PLAXIS 3D Foundation
Introductory Version
Tutorial Manual
Disclaimer:

PLAXIS is a finite element program for geotechnical applications in which soil models are used to simulate the soil behaviour. The PLAXIS code and its soil models have been developed with great care. Although a lot of testing and validation have been performed, it cannot be guaranteed that the PLAXIS code is free of errors. Moreover, the simulation of geotechnical problems by means of the finite element method implicitly involves some inevitable numerical and modeling errors. The accuracy at which reality is approximated depends highly on the expertise of the user regarding the modelling of the problem, the understanding of the soil models and their limitations, the selection of model parameters, and the ability to judge the reliability of the computational results. Hence, PLAXIS may only be used by professionals that possess the aforementioned expertise. The user must be aware of his/her responsibility when he/she uses the computational results for geotechnical design purposes. The PLAXIS organisation cannot be held responsible or liable for design errors that are based on the output of PLAXIS calculations.

Trademark

Windows® is a registered trademark of the Microsoft Corp.

Copyright PLAXIS program by:

PLAXIS bv  P.O. Box 572, 2600 AN  DELFT, Netherlands
Fax: + 31 15 257 3107; E-mail: info@plaxis.nl; Internetsite: http://www.plaxis.nl

This manual may not be reproduced, in whole or in part, by photo-copy or print or any other means, without written permission from PLAXIS bv
TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction</td>
<td>1-1</td>
</tr>
<tr>
<td>2</td>
<td>Getting started</td>
<td>2-1</td>
</tr>
<tr>
<td></td>
<td>2.1 Installation</td>
<td>2-1</td>
</tr>
<tr>
<td></td>
<td>2.2 General modelling aspects</td>
<td>2-1</td>
</tr>
<tr>
<td></td>
<td>2.3 Input procedures</td>
<td>2-3</td>
</tr>
<tr>
<td></td>
<td>2.3.1 Input of geometry objects</td>
<td>2-4</td>
</tr>
<tr>
<td></td>
<td>2.3.2 Input of text and values</td>
<td>2-4</td>
</tr>
<tr>
<td></td>
<td>2.3.3 Input of selections</td>
<td>2-5</td>
</tr>
<tr>
<td></td>
<td>2.3.4 Structured input</td>
<td>2-6</td>
</tr>
<tr>
<td></td>
<td>2.4 Starting the program</td>
<td>2-7</td>
</tr>
<tr>
<td></td>
<td>2.4.1 General settings</td>
<td>2-7</td>
</tr>
<tr>
<td></td>
<td>2.4.2 Creating a model</td>
<td>2-8</td>
</tr>
<tr>
<td>3</td>
<td>Raft foundation on overconsolidated clay (Lesson 1)</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>3.1 Geometry</td>
<td>3-1</td>
</tr>
<tr>
<td></td>
<td>3.2 Creating the input</td>
<td>3-2</td>
</tr>
<tr>
<td></td>
<td>3.3 Performing Calculations</td>
<td>3-17</td>
</tr>
<tr>
<td></td>
<td>3.4 Viewing Output Results</td>
<td>3-23</td>
</tr>
<tr>
<td>4</td>
<td>Load Capacity of a Bored Pile (Lesson 2)</td>
<td>4-1</td>
</tr>
<tr>
<td></td>
<td>4.1 Geometry</td>
<td>4-1</td>
</tr>
<tr>
<td></td>
<td>4.2 Defining calculation stages</td>
<td>4-7</td>
</tr>
<tr>
<td></td>
<td>4.3 Calculation</td>
<td>4-10</td>
</tr>
<tr>
<td></td>
<td>4.4 Viewing output results</td>
<td>4-10</td>
</tr>
<tr>
<td>5</td>
<td>A-Symmetric raft foundation (Lesson 3)</td>
<td>5-1</td>
</tr>
<tr>
<td></td>
<td>5.1 Input</td>
<td>5-2</td>
</tr>
<tr>
<td></td>
<td>5.2 Calculations</td>
<td>5-6</td>
</tr>
<tr>
<td></td>
<td>5.3 Output</td>
<td>5-8</td>
</tr>
<tr>
<td>6</td>
<td>Load Capacity of a Suction pile (Lesson 4)</td>
<td>6-1</td>
</tr>
<tr>
<td></td>
<td>6.1 Geometry</td>
<td>6-1</td>
</tr>
<tr>
<td></td>
<td>6.2 Calculations</td>
<td>6-6</td>
</tr>
<tr>
<td></td>
<td>6.3 Viewing output results</td>
<td>6-7</td>
</tr>
<tr>
<td>7</td>
<td>Excavation pit (Lesson 5)</td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>7.1 Input</td>
<td>7-1</td>
</tr>
<tr>
<td></td>
<td>7.2 Calculations</td>
<td>7-6</td>
</tr>
<tr>
<td></td>
<td>7.3 Output</td>
<td>7-7</td>
</tr>
<tr>
<td>Appendix A</td>
<td>Menu Tree</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A.1 Input menu</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A.2 Output menu</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>A.3 Curves menu</td>
<td>5</td>
</tr>
</tbody>
</table>
1 INTRODUCTION

PLAXIS 3D Foundation is a three-dimensional finite element program especially developed for the analysis of foundation structures, including off-shore foundations. It combines simple graphical input procedures, which allow the user to automatically generate complex finite element models, with advanced output facilities and robust calculation procedures. The program is designed such that a user can analyse complex constructions after only a few hours of training.

This Introductory Version is intended to show new users most of the available options of the full program. It is limited in a number of ways, as compared to the Professional Version:

- Only one set of soil parameters can be used in each calculation;
- Only one borehole can be used;
- The number of work planes is limited to a maximum of 5;
- Only one volume pile can be added, which can only be circular or square (not user defined);
- The number of calculation phases is limited to 5 phases;
- No print facilities are available;
- The output cannot be copied to the clipboard.

This Tutorial Manual is a simplified version of the Tutorial Manual supplied with the Professional Version of PLAXIS 3D Foundation and takes the limitations of the Introductory Version in account. It is intended to help new users become familiar with PLAXIS 3D Foundation. The various lessons deal with a range of interesting practical applications and cover most of the program features. However, the use of soil models is limited to the basic Mohr-Coulomb model. Users are expected to have a basic understanding of soil mechanics and should be able to work in a Windows environment.

It is helpful, but not required, that users are familiar with the standard PLAXIS (2D) deformation analysis program, as many of the interface objects are similar. It is strongly recommended that the lessons are followed in the order that they appear in the manual. The tutorial lessons are also available in the examples folder of the PLAXIS Introductory program directory and can be used to check your results.

The Tutorial Manual does not provide theoretical background information on the finite element method, nor does it explain the details of the various soil models available in the program. The latter can be found in the Material Models Manual, as included in the manuals of the full version of the PLAXIS program, and theoretical background is given in the corresponding Scientific Manual. For detailed information on the available program features, the user is referred to the Reference Manual. The manuals are included on the Introductory CD. The latest version of the manuals can be downloaded from the PLAXIS website for free (http://www.plaxis.com).
2 GETTING STARTED

This chapter describes some of the notation and basic input procedures that are used in the PLAXIS 3D Foundation program. In the manuals, menu items or windows specific items are printed in *italics*. Whenever keys on the keyboard need to be pressed, this is indicated by the name of the key or button in brackets, (for example the <Enter> key).

2.1 INSTALLATION

The installation procedure of the Introductory Version is fully automated. If problems occur after the installation, the installation program can be run again to repair the program.

2.2 GENERAL MODELLING ASPECTS

For each new 3D project to be analysed it is important to create a geometry model first. A geometry model is a representation of a real three-dimensional problem and is defined by work planes and boreholes. A geometry model should include a representative division of the subsoil into distinct soil layers, structural objects, construction stages and loadings. The model must be sufficiently large so that the boundaries do not influence the results of the problem to be studied. The two components of a geometry model are described below in more detail.

*Boreholes*

Boreholes are objects in the geometry model, defining the ground surface, soil layers and the water table at a certain location. In the Introductory Version only two boreholes can be used to define the stratigraphy of the soil for the project. During 3D mesh generation, the position of soil layers is interpolated between bore-holes and the mesh is generated such that the boundaries between soil layers always coincide with the boundaries of elements.

*Work planes*

Work planes are horizontal planes, with different \( y \)-coordinates, presenting a top-view of the geometry model at the specified vertical level. They are used to create the loads and structures in the model. Each work plane holds the same geometry lines, but the distance between work planes may vary, as defined by the input of \( y \)-coordinates. Work planes may be used to activate or deactivate point loads, line loads, distributed loads or structural elements. In the Introductory Version, a maximum of five work planes can be created. Within work planes, points, lines and clusters can be used to describe a 2D geometry model. These three components are described below.
Figure 2.1  Coordinate system used in the PLAXIS environment. An example of a work plane is shown.

**Points**  
Points form the start and end of lines. Points can also be used for the positioning of springs and point forces and for local refinements of the finite element mesh.

**Lines**  
Lines are used to define the physical boundaries of the geometry, contours of structures and discontinuities in the geometry such as walls or beams, or excavation areas. A line can have several functions or properties.

**Clusters**  
Clusters are areas that are fully enclosed by lines. PLAXIS automatically recognises clusters based on the input of geometry lines. Within a cluster the properties are homogeneous. Hence, clusters can be regarded as homogeneous parts of a structure or soil layer. Actions related to clusters apply to all elements in the cluster.

After the creation of the 2D geometry model in a work plane, a 2D finite element mesh composed of 6-node triangles can automatically be generated, based on the composition of clusters and lines in the geometry model. If the 2D mesh is satisfactory, an extension into the third dimension can be made. In a 3D finite element mesh three types of components can be identified, as described below.

**Elements**  
During the generation of the mesh, the geometry is divided into 15-node wedge elements. These elements are composed of the 6-node triangular faces in the work planes, as generated by the 2D mesh generation, and 8-node quadrilateral faces in \( y \)-direction. In addition to the volume elements, which are generally
used to model the soil, compatible 3 node line elements, 6-node plate elements and 16-node interface elements may be generated to model structural behaviour and soil-structure interaction respectively.

**Nodes**

The wedge elements as used in the 3D Foundation program consist of 15 nodes. The distribution of nodes over the elements is shown in Figure 2.2. Adjacent elements are connected through their common nodes. During a finite element calculation, displacements \( (u_x, u_y, u_z) \) are calculated at the nodes. Nodes may be pre-selected for the generation of load-displacement curves.

**Stress points**

In contrast to displacements, stresses and strains are calculated at individual Gaussian integration points (or stress points) rather than at the nodes. A 15-node wedge element contains 6 stress points as indicated in Figure 2.2. Stress points may be preselected for the generation of stress and strain diagrams.

![Figure 2.2 Distribution of nodes (●) and stress points (∗) in a 15-node wedge element](image)

**2.3 INPUT PROCEDURES**

In PLAXIS, input is specified by using the mouse and also by keyboard input. In general, four types of input may be identified:
• Input of geometry objects (e.g. drawing a geometry line)
• Input of text (e.g. entering a project name)
• Input of values (e.g. entering the soil unit weight)
• Input of selections (e.g. choosing a soil model)

The mouse is generally used for drawing and selection purposes, whereas the keyboard is used to enter text and values.

2.3.1 INPUT OF GEOMETRY OBJECTS

The creation of a geometry model is based on the input of points and lines. This is done by means of a mouse pointer in the draw area. Several geometry objects are available from the menu or from the toolbar. The input of most of the geometry objects is based on a line drawing procedure. In any of the drawing modes, lines are drawn by clicking on the left mouse button in the draw area. As a result, a first point is created. On moving the mouse and left clicking with the mouse again, a new point is created together with a line from the previous point to the new point. The line drawing is finished by clicking the right mouse button, or by pressing the <Esc> key on the keyboard.

2.3.2 INPUT OF TEXT AND VALUES

As for any software, some input of values and text is required. The required input is specified in the edit boxes. Multiple edit boxes for a specific subject are grouped in windows. The desired text or value can be typed on the keyboard, followed by the <Enter> key or the <Tab> key. As a result, the value is accepted and the next input field is highlighted. In some countries, like The Netherlands, the decimal dot in floating point values is represented by a comma. The type of representation that occurs in edit boxes and tables depends on the country setting of the operating system. Input of values must be given in accordance with this setting.

Many parameters have default values. These default values may be used by pressing the <Enter> key without other keyboard input. In this manner, all input fields in a window can be entered until the OK button is reached. Pressing the OK button confirms all values and closes the window. Alternatively, selection of another input field, using the mouse, will result in the new input value being accepted. Input values are confirmed by left clicking the OK button with the mouse.

Pressing the <Esc> key or left clicking the Cancel button will cancel the input and restore the previous or default values before closing the window.

The spin edit feature is shown in Figure 2.3. Just like a normal input field a value can be entered by means of the keyboard, but it is also possible to left-click on the ▲ or ▼ arrows at the right side of each spin edit to increase or decrease its value by a predefined amount.
2.3.3 INPUT OF SELECTIONS

Selections are made by means of radio buttons, check boxes or combo boxes as described below.

Radio buttons
In a window with radio buttons only one item may be active. The active selection is indicated by a black dot in the white circle in front of the item. Selection is made by clicking the left mouse button in the white circle or by using the up and down arrow keys on the keyboard. When changing the existing selection to one of the other options, the 'old' selection will be deselected. An example of a window with radio buttons is shown in Figure 2.4. According to the selection in Figure 2.4 the project that will be opened is set to a New project.

Check boxes
In a window with check boxes more than one item may be selected at the same time. The selection is indicated by a black tick mark in a white square. Selection
is made by clicking the left mouse button in the white square or by pressing the space bar on the keyboard. Another click on a preselected item will deselect the item. An example of check boxes is shown in Figure 2.5.

**Combo boxes**

A combo box is used to choose one item from a predefined list of possible choices. An example of a window with combo boxes is shown in Figure 2.6. As soon as the ▼ arrow at the right hand side of the combo box is left clicked with the mouse, a pull down list occurs that shows the possible choices. A combo box has the same functionality as a group of radio buttons but it is more compact.

### 2.3.4 STRUCTURED INPUT

The required input is organised in a way to make it as logical as possible. The Windows environment provides several ways of visually organising and presenting information on the screen. To make the reference to typical Windows elements in the next chapters easier, some types of structured input are described below.

![Page control and tab sheets](image)

**Figure 2.7 Page control and tab sheets**

**Page control and tab sheets**

An example of a page control with three tab sheets is shown in Figure 2.7. In this figure the second tab sheet for the input of the model parameters of the Mohr-Coulomb soil model is active. Tab sheets are used to handle large amounts of different types of data which do not all fit in one window. Tab sheets can be activated by left-clicking on the corresponding tab or using <Ctrl>+<Tab> on the keyboard.
**Group boxes**

Group boxes are rectangular boxes with a title. They are used to cluster input items that have common features. In Figure 2.7, the active tab sheet contains three group boxes named *Stiffness*, *Strength* and *Alternatives*.

### 2.4 STARTING THE PROGRAM

It is assumed that the program has been installed using the procedures described in the General Information part of the manual. It is advisable to create a separate directory in which data files are stored. The PLAXIS 3D Foundation Introductory Version can be started by selecting the *PLAXIS 3D Foundation* input icon in the PLAXIS 3D Foundation Introductory Version program group. The user is asked whether to define a new problem or to retrieve a previously defined project. If the latter option is chosen, the program lists four of the most recently used projects from which a direct choice can be made. Choosing the item <<more files>> that appears first in this list will give a file requester from which the user can choose any previously defined project for modification.

#### 2.4.1 GENERAL SETTINGS

If a new project is to be defined, the *General settings* window as shown in Figure 2.8 appears. This window consists of two tab sheets. In the first tab sheet miscellaneous settings for the current project have to be given. A filename has not been specified here; this can be done when saving the project.

![General Settings - Project tab sheet](image)

The user can enter a brief description of the problem as the title of the project as well as a more extended description in the *Comments* box. The title is proposed as the default filename and appears on output plots. The comments box is simply a convenient place to
store information about the analysis. Also, the magnitude of the standard earth gravity and the unit weight of water can be specified here.

The second tab sheet is shown in Figure 2.9. In addition to the basic units of Length, Force and Time, the minimum dimensions of the draw area must be given here, such that the geometry model will fit the draw area. The general system of axes is such that the x-axis points to the right and the z-axis points downwards in the draw area. $X_{\text{min}}$ is the lowest x-coordinate of model, $X_{\text{max}}$ the highest x-coordinate, $Z_{\text{min}}$ the lowest z-coordinate and $Z_{\text{max}}$ the highest z-coordinate of the model. Y-coordinates are not entered in the General settings dialog, but during the input of bore holes and work planes.

![General settings - Dimensions tab sheet](image)

Figure 2.9  General settings - Dimensions tab sheet

In practice, the draw area resulting from the given values of $X_{\text{min}}$, $X_{\text{max}}$, $Z_{\text{min}}$ and $Z_{\text{max}}$ will be larger than the values given in the four spin edits. This is partly because PLAXIS will automatically add a small margin to the dimensions and partly because of the difference in the width/height ratio between the specified values and the screen.

### 2.4.2 CREATING A MODEL

When the general settings are entered and the OK button is clicked, the main window appears. This main window is shown in Figure 2.10. The most important parts of the main window are indicated and briefly discussed below. For a more extensive description the reader is referred to the Reference Manual.
**Input menu**

The Input menu contains all input items and operation facilities of the Input program. Most items are also available as buttons in the tool bar.

**Tool bar (File)**

This tool bar contains buttons for file operations, corresponding with the options in the File menu. It also contains buttons to start the other sub-programs of the PLAXIS 3D Foundation Introductory Version (Output, Curves).

**Tool bar (Edit)**

This tool bar contains buttons for editing operations, corresponding with the options in the Edit menu.

**Tool bar (View)**

This tool bar contains buttons for viewing operations such as zooming into a particular part of the draw area. The buttons correspond with the options in the View menu.
**Tool bar (General)**

This tool bar contains buttons for functionalities that apply to the Model mode as well as to the Calculation mode, among which the use of the selection tool and the selection of a work plane.

**Tool bar (Model)**

This tool bar contains buttons related to the creation of a geometry model, such as Geometry lines, Piles, Beams, Walls, Floors, Line fixities, Springs, Bore holes and loads, as well as options for 2D and 3D mesh generation.

**Tool bar (Calculation)**

This tool bar contains buttons related to the definition of calculation phases.

**Rulers**

At both the left and the top of the draw area, rulers indicate the physical coordinates, which enables a direct view of the geometry dimensions.

**Draw area**

The draw area is the drawing sheet on which the geometry model is created. The draw area can be used in the same way as a conventional drawing program. The grid of small dots in the draw area can be used to snap to regular positions.

**Origin**

If the physical origin is within the range of given dimensions, it is represented by a small circle, with an indication of the $x$- and $z$-axes.

**Manual input**

If drawing with the mouse does not give the desired accuracy, then the Manual input line can be used. Values for $x$- and $z$-coordinates can be entered here by typing the corresponding values separated by a space. The manual input can also be used to assign new coordinates to a selected point.

**Cursor position indicator**

The cursor position indicator gives the current position of the mouse cursor both in physical units and screen pixels.

Some of the objects mentioned above can be removed by deselecting the corresponding item from the View menu.
For both toolbars, the name and function of the buttons is shown after positioning the mouse cursor on the corresponding button and keeping the mouse cursor still for about a second; a hint will appear in a small yellow box below the button. The available hints for both toolbars are shown in Figure 2.11. In this Tutorial Manual, buttons will be referred to by their corresponding hints.

For detailed information on the creation of a complete finite element model, the reader is referred to the various lessons that are described in this Tutorial Manual.
In the previous chapter some general aspects and basic features of the PLAXIS 3D Foundation program were presented. In this chapter a first application is considered, namely the settlement of a raft foundation on clay. This is the first step in becoming familiar with the practical use of the program.

The general procedures for the creation of a geometry, the generation of a finite element mesh, the execution of a finite element calculation and the evaluation of the output results are described here in detail. The information provided in this chapter will be utilised in later lessons. Therefore, it is important to complete this first lesson before attempting any further tutorial examples.

### 3.1 GEOMETRY

This exercise deals with the construction and loading of a raft foundation on a lightly overconsolidated Lacustrine Clay. Below the clay layer there is a stiff rock layer that forms a natural boundary for the considered geometry. The rock layer is not included in the geometry; instead an appropriate boundary condition is applied at the bottom of the clay layer. The purpose of the exercise is to find the settlement of the raft foundation and the structural forces in the floor slab.

The building is composed of a basement level and 4 floors above ground level, see Figure 3.1. In this exercise only the basement will be modelled. The loads from the upper floors are transferred to the floor slab by columns. Each column bears a load of 6000 kN, as sketched in Figure 3.2.

![Figure 3.1 Side view of building on raft foundation](image)
3.2 CREATING THE INPUT

Start the PLAXIS 3D Foundation input program. A *Create/Open project* dialog box will appear in which you can select an existing project or create a new one. Choose *New Project* and click the *OK* button (see Figure 3.3). Now the *General settings* window appears, consisting of the two tab sheets *Project* and *Dimensions* (see Figure 3.4 and Figure 3.5).
General Settings

The first step in every analysis is to set the basic parameters of the finite element model. This is done in the General settings window. These settings include the description of the problem, the basic units and the size of the draw area. To enter the appropriate settings for the raft foundation calculation follow these steps:

- In the Project tab sheet, enter ‘Lesson 1’ in the Title box and type ‘Settlements of a raft foundation’ in the Comments box.

- The General box indicates a fixed gravity of 1.0 G, in the vertical direction downward (-Y). Also, the value of the acceleration of gravity (1.0 G) can be entered in the Earth gravity box. This should be kept to the default value of 9.8 m/s² for this exercise.

- In the γwater box the unit weight of water can be entered. Keep this to the default value of 10 kN/m³. Click the Next button below or click the Dimensions tab sheet.

![General Settings Window](Image)

Figure 3.4 Project tab sheet of the General settings window

- In the Dimensions tab sheet, keep the default units in the Units box (Unit of Length = m; Unit of Force = kN; Unit of Time = day).

- In the Geometry Dimensions box the size of the required draw area must be entered. When entering the upper and lower coordinate values of the geometry to be created, a small margin is automatically added so that the geometry will fit well within the draw area. Enter -50.0, 50.0, -30.0, 30.0 for Xmin, Xmax, Zmin, Zmax respectively.

- The Grid box contains the settings for the grid spacing. The grid provides a matrix of dots on the screen that can be used as reference points. It may also be used for snapping to regular points during the creation of a geometry. The distance between the dots is determined by the Spacing value. The spacing of
snapping points can be further divided into smaller intervals by the *Number of intervals* value. Enter 1.0 for the spacing and 1 for the intervals.

- Click the *OK* button to confirm the settings. Now the draw area appears in which the geometry model can be drawn.

![General Settings Window](image)

**Figure 3.5** Dimensions tab sheet of the General settings window

**Hint:** In the case of a mistake or for any other reason that the general settings need to be changed, you can access the General settings window by selecting the General settings option from the File menu.

Once the general settings have been completed, the draw area appears with an indication of the origin and direction of the system of axes. The *x*-axis is pointing to the right and the *z*-axis is pointing downwards on the screen. The *y*-axis is perpendicular to the draw area, pointing towards the user. A first cluster (area that is fully enclosed by geometry lines) with dimensions equal to the dimensions entered in the *General settings* window is also automatically created. A geometry model can be created in this draw area, which will be considered later on. First, we will consider the extension into the vertical direction (*y*-direction) by the definition of work planes.

**Work planes**

Work planes are horizontal layers with different *y*-coordinates, at which the structural objects, loads and construction stages can be defined. Work planes are needed at each level where a discontinuity in the geometry or the loading occurs in the initial situation or in the construction process. They are defined in the *Work planes* window. This window can be opened with the *Work planes* button, found on the toolbar just left of the *Active Work plane* combo-box, or from the *Work planes* option in the *Geometry* menu.
One work plane has already been automatically created at \( y = 0.0 \). For this first project, we need to define two additional work planes. To do this, follow these steps:

- **Open the Work planes window** by clicking the Work planes button on the toolbar. A new window will appear, in which the automatically generated work plane at \( y = 0 \) is shown. A vertical cross section is shown, indicating in red the currently selected work plane.
- Click the **Add** button. A new work plane is inserted at \( y = -3.0 \) m, below the current work plane.
- Select the new work plane \((y = -3.0)\) by clicking on the entry in the table on the left and enter a value \( y = -28.0 \) m. Press <Enter> to accept the new value.
- Click the **Insert** button, and change the \( y \)-coordinate of the new work plane to \( y = -2.0 \) m. After accepting this value, the overview of work planes is updated, as shown in Figure 3.6.

![Figure 3.6 Work planes window](image)

- Click the **OK** button to close the Work planes window and return to the draw area.

**Building Geometry**

To create objects, you can either use buttons from the toolbar or the options from the Geometry menu. For a new project the Select button is already active. For this project, we will start by defining the basement walls and floor. First we need to select the correct work plane.

- From the Active work planes combo-box, select the work plane at \( y = 0.0 \) m. Click on the arrow to open the combo box and click on the entry 0.0.

![Figure 3.7 Active work plane combo box](image)
In order to construct the outside walls of the building, follow these steps:

Select the **Wall** option (the fifth button on the geometry toolbar).

- Position the cursor at the coordinate (-19.0, 9.0). Check that the units in the status bar read -19.0 x 9.0 and click the left mouse button once. The first geometry point in addition to the default geometry boundary points (number 4) has now been created.

- Move to the right to position (19.0, 9.0). Click the left mouse button to generate the second point (number 5). At the same time the first wall is created from point 4 to point 5, below the current work plane. This is indicated by a thick blue line. Interfaces are automatically added to both sides of the wall. These are indicated by black dashed lines. Interfaces are used to model the soil-structure interaction.

- Move upwards to position (19.0, -9.0) and click again.

- Move to position (-19.0, -9.0) and click again.

- Finally, move back to point 4, position (-19.0, 9.0) and click the left mouse button again. Since the latter point already exists, no new point is created, but only an additional geometry line is created from point 7 to point 4.

- Click the right mouse button to stop drawing.

**Hint:**
When adding a geometry line to a work plane, this geometry line will be repeated in all other work planes. When structural objects such as floors and beams are added, these will be added to the currently active work plane only. Walls will be added below the currently active work plane. In addition, a corresponding geometry line will be added to all other work planes.

- After the walls have been defined, we can easily add the basement floor.

- From the **Active work planes** combo box, select the work plane at \( y = -2.0 \) m.

Select the **Floor** option from the geometry toolbar.

- Click anywhere within the area enclosed by the walls. This area should now be coloured olive (green), indicating that a floor has been added.

**Hint:**
Incorrectly positioned points and lines can be modified or deleted by first choosing the **Selection** button from the toolbar. To move a point or line, select the point or line and drag it to the desired position. To delete a point or line, select the point or line and press the <Delete> button on the keyboard.
Unwanted drawing operations can be removed by pressing the *Undo* button from the toolbar or by selecting the *Undo* option from the *Edit* menu or by pressing `<Ctrl><Z>` from the keyboard.

Lines can be drawn perfectly horizontal or vertical by holding down the `<Shift>` key on the keyboard while moving the mouse.

**Loads**

After the basement geometry has been fully defined, the load resulting from the building itself has to be modelled. This load is transferred by columns from the top floors onto the basement floor. For this exercise, there is no need to model the columns themselves. The loads can be modelled using point loads acting directly on the basement floor. As Plaxis 3D Foundation cannot handle single unconnected points during mesh generation, extra geometry lines have to be added before entering the actual loads.

Select the *Geometry Line* tool from the geometry toolbar or from the *Geometry* menu.

- Make sure the work plane at $y=-2.0$ m is selected and move the cursor to (-10.0, -3.0) and click.
- Now move the cursor to (10.0, -3.0) and click again.
- Right-click to end drawing this geometry line.
- Also draw a geometry line from (-10.0, 3.0) to (10.0, 3.0).

The columns are spaced 10 metres apart, as indicated in Figure 3.2. To enter the loads:

Select the *Point load* tool from the geometry toolbar.

- Move the cursor to (-10.0, 3.0) and click to add the point load. The point load has a default value of 1 kN, acting in the downward y-direction, perpendicular to the work plane. Such a load is represented by a blue circle with a letter A next to it.
- Repeat this action at locations (-10.0, -3.0), (0.0, 3.0), (0.0, -3.0), (10.0, 3.0), and (10.0, -3.0).

This way, all loads are defined with a default value of 1 kN acting in the negative y-direction. Later on, in the definition of calculation stages, the value of all loads will be changed to the desired values.
Borehole

All structural information on the geometry in the vertical direction has been entered using work planes. Information on the soil layers and the water table is entered in a different way, using so called Boreholes. Boreholes are locations in the draw area at which the information on the location of soil layers and the water table is given. If multiple boreholes are defined, PLAXIS 3D Foundation will automatically interpolate between the boreholes, and derive the position of the soil layers from the borehole information.

Hint: PLAXIS 3D Foundation can also deal with layers that are discontinuous, i.e. only locally present in the model area. In such cases, so called degenerated elements are used. See section 3.3.11 of the Reference Manual for more information.

In the current example, only one soil layer is present, and only a single borehole is needed to define the soil layer. In order to define the borehole, follow these steps:

Select the Borehole tool from the geometry toolbar.

- Click at a location in the cluster that represents the soil. It is suggested to click on (-50.0, -30.0).
- This places a borehole at location (-50.0, -30.0) and opens the Borehole window. The top and bottom boundaries of the borehole will be determined automatically. They correspond to \( y = 0.0 \) m and to the lowest work plane in the model, in this case \( y = -28.0 \) m. For this exercise, these values are correct and no change is needed.
- In the Water level box, set the water level to \( y = -2.0 \) m. Do not close the window.
- All geometry objects have now been defined. Before the mesh can be generated, material properties have to be assigned to all objects.
Material Data Sets

In order to simulate the behaviour of the soil and the structures, a suitable material model and appropriate material parameters must be assigned to the geometry. In PLAXIS, soil properties are collected in material data sets and the various data sets are stored in a material database. From the database, a data set can be assigned to one or more clusters or structural objects. Different objects have different types of data sets, and these types cannot be mixed.

PLAXIS 3D Foundation distinguishes between material data sets for Soils & Interfaces, Beams, Walls, Floors and Springs. The input of material data sets is generally done after the input of all geometry objects. Before the mesh can be generated material data sets have to be assigned to all clusters and structures.

The input of material data sets can be selected by means of the Materials button on the toolbar, from the options available in the Materials menu or from the Materials button in the Borehole window.

Soils & Interfaces

To create a material set for the clay layer, using the last of the three possible methods, follow these steps:

- The Borehole window should still be open. If it is not open, choose the Select tool from the toolbar and double-click on the borehole at (-50,-30).

![Borehole window](image)

Figure 3.9 The borehole window

- This opens the Borehole window and shows the layers in the selected borehole. In this case only a single layer is present, with a bottom at -28 m and a top at 0 m.
Open the Material Sets window by clicking on the Materials button.

For this lesson, the material set is already filled. Select the material set called Data set 1. Then click the Edit button on the lower side of the Material Sets window. A dialog box will appear with three tab sheets: General, Parameters and Interfaces (see Figure 3.10 and Figure 3.11).

![Figure 3.10 General tab sheet of the soil and interfaces data set window](image1)

![Figure 3.11 Parameters tab sheet of the soil and interfaces data set window](image2)

Enter ‘Lacustrine clay’ as the Identification of the data set. Check the model parameters as given in Table 1 with the parameters in the General tab sheet. By clicking the Next button or clicking the Parameters tab you can proceed to check the model parameters. The parameters appearing on the Parameters tab sheet depend on the selected material model (in this case the Mohr-Coulomb model). The Mohr-Coulomb model involves only five basic parameters ($E$, $\nu$, $c$, $d$, $\phi$).
$\phi$, $\psi$). See the Material Models manual for a detailed description of the different soil models and their corresponding parameters.

Table 3.1 Material properties of the clay layer

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Drained</td>
<td>-</td>
</tr>
<tr>
<td>Unit weight of soil above phreatic level</td>
<td>$\gamma_{\text{unsat}}$</td>
<td>17.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Unit weight of soil below phreatic level</td>
<td>$\gamma_{\text{sat}}$</td>
<td>18.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Young’s modulus (constant)</td>
<td>$E_{\text{ref}}$</td>
<td>3000</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>$\nu$</td>
<td>0.3</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion (constant)</td>
<td>$c_{\text{ref}}$</td>
<td>10.0</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Friction angle</td>
<td>$\phi$</td>
<td>30.0</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$\psi$</td>
<td>0.0</td>
<td>°</td>
</tr>
</tbody>
</table>

- On the third tab sheet the parameters for Interfaces can be entered. Click the Interfaces tab or the Next button to proceed to the Interfaces tab. For this exercise the interface Strength will be left on the default setting Rigid. Click the OK button to confirm the input of the current material data set. Now the created data set will appear in the tree view of the Material Sets window.

- Drag the set ‘Lacustrine Clay’ from the Material Sets window to the graphical soil column in the Borehole window and drop it there (release the left mouse button). Notice that the cursor changes shape to indicate whether or not it is possible to drop the data set. Correct assignment of the data set to the soil layer is indicated by a change in the colour of the layer.

- Click the OK button in the Material Sets window to close the database.

- The Soil tab sheet in the Borehole window may be skipped in this exercise. Click the OK button in the Borehole window to return to the draw area.

**Hint:** PLAXIS distinguishes between a project database and a global database of material sets. The global database is not available in the Introductory Version. In the Professional Version data sets may be exchanged from one project to another using the global database.

> Existing data sets may be changed by opening the material sets window from the general tool bar.

> The program performs a consistency check on the material parameters and will give a warning message in the case of a detected inconsistency in the data.
Walls

Walls and floors also need a material data set. To create the data set for the wall, follow these steps:

- Set the Active work plane to \( y = 0.0 \) m.

Open the Material sets window by clicking on the corresponding button on the toolbar. In the material data set window, set the Set type to Walls (see Figure 3.12) and select the existing data set.

![Figure 3.12 Input for the Walls material data set](image)

- Check the properties given in Table 3.2. As the material is considered homogeneous, the same value needs to be entered for each triplet of \( E \), \( G \) and \( \nu \). To this end the Isotropic option has been selected.

Table 3.2  Material properties of the Basement Wall (wall)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Basement Wall</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Behaviour</td>
<td>Type</td>
<td>Linear</td>
<td>-</td>
</tr>
<tr>
<td>Thickness</td>
<td>( d )</td>
<td>0.3</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>( \gamma )</td>
<td>24</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>( E )</td>
<td>( 1\times10^7 )</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>( G )</td>
<td>( 4.167\times10^6 )</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>( \nu )</td>
<td>0.2</td>
<td>-</td>
</tr>
</tbody>
</table>

- Click the OK button to close the data set.
Drag and drop the Basement Wall data set to the wall in the draw area. If the Material sets window partially obscures the walls of the building, the window can be dragged aside. The cursor will change to indicate if the material set can be dropped. The walls will briefly flash red and change colour from light blue to dark blue, indicating that a material data set has been assigned successfully.

![Image](image_url)

**Figure 3.13 Inspecting the material data set for a structural element**

**Hint:** To check whether the correct material set has been assigned to a structural element, double click the object, and select it from the select window that appears. A window will appear, see Figure 3.13, indicating the type of object and the material data set assigned to it. The Change button can be used to assign a different material data set to the object.

**Floor**

The material properties for the floor are entered in a similar manner. Without first closing the Material sets window, do the following:

- Set the Active work plane to \( y = -2.0 \) m.
- Set the Set type in the Material sets window to Floors.
- Select the existing data set and check the properties given in Table 3.3 and click OK. Drag and drop the Basement Floor data set to the floor cluster in the draw area. The floor will briefly flash red and change colour from light green to dark green. Close the Material sets window by clicking OK.

**Table 3.3 Material properties of the Basement Floor (floor)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Basement Floor</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of behaviour</td>
<td>Type</td>
<td>Linear</td>
<td>-</td>
</tr>
<tr>
<td>Thickness</td>
<td>( d )</td>
<td>0.5</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>( \gamma )</td>
<td>24</td>
<td>kN/m(^3)</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>( E )</td>
<td>( 1 \cdot 10^7 )</td>
<td>kN/m(^2)</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>( G )</td>
<td>( 4.167 \cdot 10^6 )</td>
<td>kN/m(^2)</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>( \nu )</td>
<td>0.2</td>
<td>-</td>
</tr>
</tbody>
</table>
2D Mesh Generation

When the geometry model is complete and all borehole information has been entered, it is recommended to generate a 2D finite element mesh before generating a full 3D mesh. PLAXIS 3D Foundation allows for a fully automatic mesh generation procedure, in which the geometry is divided into volume elements and compatible structure elements, if applicable. The mesh generation takes full account of the position of lines and points in the geometry model, so that the exact position of layers, loads and structures is accounted for in the finite element mesh. The 2D mesh generation process is based on a robust triangulation principle that searches for optimised triangles and which results in an unstructured mesh. Although unstructured meshes do not form regular patterns of elements, the numerical performance of these meshes is usually better than structured meshes with regular arrays of elements. In addition to the mesh generation itself, a transformation of the input data (properties, boundary conditions, material sets, etc.) from the geometry model (points, lines and clusters) to the finite element mesh (elements and nodes) is made.

![Figure 3.14 2D finite element mesh of the geometry](image)

To generate the mesh, follow these steps:

1. Click the Generate 2D mesh button in the toolbar or select the Generate 2D mesh option from the Mesh menu.

After the generation of the mesh a new window is opened (Output window) in which the generated mesh is presented (see Figure 3.14). This window can be used to inspect the generated mesh and to decide if mesh refinement is required.

- Click the Update button to return to the Input window.
- Large displacement gradients are expected around and under the basement. Hence, it is appropriate to have a finer mesh around and under the building. Select the cluster that represents the basement floor. The floor is now indicated in red as shown in Figure 3.15. From the Mesh menu, select the option Refine
cluster. As a result, a local refinement of the indicated cluster is visible in the presented mesh. Click the Update button to return.

Figure 3.15 The selected Floor cluster

- If necessary, the mesh can be further optimised by performing global or local refinements. These mesh refinements are considered in a later lesson. Here it is suggested that the current mesh is accepted.

**Hint:** By default, the Global coarseness of the mesh is set to Coarse, which is adequate as a first approach in many cases. The Global coarseness setting can be changed in the Mesh menu. In addition, options are available to refine the mesh globally or locally.

At this stage of input, it is still possible to modify parts of the geometry or to add geometry objects. If modifications are made at this stage, the finite element mesh has to be regenerated.

The automatically generated mesh may not be perfectly suitable for the intended calculation. Therefore it is recommended that the user inspect the mesh and makes refinements if necessary.

### 3D Mesh Generation

After generation of the 2D mesh, the model must be extended to a fully 3D mesh. This can be done by clicking on the 3D mesh generation button or selecting the corresponding option from the Mesh menu. The information in vertical direction on layer boundaries, construction levels and changes in the geometry has already been entered, using work planes and boreholes. No extra information is needed in order to generate the 3D mesh. The 3D mesh is created by connecting the corners of the 2D triangular elements to the corresponding points of the corresponding elements in the next work plane. In this way a 3D mesh, composed of 15-noded wedge elements is formed. Where needed extra element levels are automatically introduced, so that the size of the elements in \( y \)-direction is about equal to the average element size defined for the 2D mesh. If multiple boreholes are used and not all layers are present in all boreholes, so-called degenerated elements will be introduced, to deal with the transition between the various layers. See section 3.3.11 Boreholes of the Reference Manual for more details.
To generate the 3D mesh, follow these steps:

Click the *Generate 3D mesh* button on the toolbar or select *Generate 3D mesh* from the *Mesh* menu. The 3D mesh generation procedure is started and the 3D mesh is displayed in the *Output* window. An additional element level is automatically introduced between the work planes at -2 m and -28 m to reduce the element size in y-direction. The 3D mesh and the various structural elements are shown in two different windows. The arrow keys of the keyboard allow the user to rotate the model so that it can be viewed from any direction (see Figure 3.16).

- Click the *Update* button to return to the *Input* program.

![Generated 3D mesh in the Output window](image)

**Figure 3.16** Generated 3D mesh in the Output window

**Hint:** If the distance between two adjacent work planes is significantly larger than the average (2D) element size, the 3D mesh generation procedure will automatically generate *intermediate element levels* (see Figure 3.16) to avoid badly shaped elements.
3.3 PERFORMING CALCULATIONS

Once the mesh has been generated, the finite element model is complete. Before the actual calculation is started, the calculation stages have to be defined. The first of these will be the definition of initial conditions. Other stages can be the excavation and construction of the basement or the activation of loads.

Click the Calculation button to switch to calculation mode.

- The program proposes to save the model. Click Yes to do so and save the model under its predefined name (Lesson 1.PF3i).

The definition of calculation stages, such as switching on and off parts of the geometry, assigning different material data sets to clusters or structural elements or changing the magnitude of loads, is done in the calculation mode of the Input program. Clicking the Calculation button will hide the geometry model toolbar and show the calculation toolbar. This toolbar, see Figure 3.17, contains a calculation phases combo box and a number of buttons to define calculation phases, perform the calculation and activate the Output program, in order to view the results.

![Figure 3.17 The Calculations toolbar](image)

The calculation mode of the Input program is a separate mode where calculation phases are defined and calculations can be started (see page 3-19).

- Click the Phases button to open the Phases window (see Figure 3.18).

![Figure 3.18 The Phases window with the General tab sheet](image)
In the Phases window you can activate and deactivate calculation phases, and set the parameters for the calculation procedure. All calculation phases appear in the list at the lower part of the window. A blue arrow indicates that the phase is active and will be calculated, while a white arrow means the phase is deactivated.

As in all PLAXIS programs the 3D Foundation program has convenient procedures for automatic load stepping and for the activation and deactivation of loads and parts of the geometry (staged construction). These procedures can be used for many practical applications. Staged construction is a very useful type of loading input. In this special PLAXIS feature it is possible to change the geometry and load configuration by deactivating or reactivating loads, volume elements or structural objects as created in the geometry input. Staged construction provides an accurate and realistic simulation of the various loading, construction and excavation processes. This option can also be used to reassign material data sets to clusters or structural elements.

Initial Conditions

Before starting the actual calculations the initial conditions must be generated. In general, the initial conditions comprise the initial geometry configuration and the initial stress state. The initial water conditions for the clay layer have been entered already in the Borehole window. These conditions are also taken into account to calculate the initial effective stress state. When a new project has been defined, a first calculation phase, named ‘Initial phase’, is automatically created and selected in the Phase list combo-box and the Phases window. All structural elements and loads that are present in the geometry are initially automatically switched off, only the soil clusters are initially active.

In PLAXIS 3D Foundation two methods are available to generate the initial stresses, gravity loading or the K0 procedure. By default gravity loading is used, which requires no additional actions except for running the calculation. In this example, however, the K0 procedure will be used.

**Hint:** The K0 procedure may only be used for horizontally layered geometries with a horizontal ground surface and, if applicable, a horizontal phreatic level. See the Reference Manual for more information on the K0 procedure.

> The default value of $K_0$ is based on Jaky's formula: $K_0 = 1 - \sin \phi$. If the value was changed, the default value can be regained by entering a negative value for $K_0$.

In order to generate the initial stresses according to the $K0$ procedure, follow these steps:

- In the Phases window select the Initial phase.

- In the General tab sheet, the Calculation type is set to the default of Gravity loading. In order to generate initial stresses according to the $K_0$ procedure, select $K0$ procedure from the Calculation type combo box.
Click the **Parameters** button or select the **Parameters** tab.

If the *K0 procedure* calculation type is selected, the Parameters tab sheet contains the *K0 procedure* input fields. In this tab sheet, accept the default values of *K₀* as suggested by PLAXIS.

**Defining Construction Stages**

After the definition of the initial conditions, the construction of the foundation and the loading can be modelled. This will be done in two separate calculation phases, which need to be added. To do this, follow these steps:

- In the list of calculation phases double click **Phase 1**. A blue arrow indicates that the phase is active.

- In the **General** tab sheet, write (optionally) an appropriate name for the new phase in the **ID** box (for example ‘Excavation’) and select the phase from which the current phase should start (in this case the calculation phase can only start from phase 0 - *Initial phase*, which contains the initial stress state).

- Leave the **Calculation type** to **Plastic** and click the **Parameters** tab to open the **Parameters** tab sheet.

![Phases window](image)

*Figure 3.19  The Parameters tab sheet of the Phases window*

- The **Parameters** tab sheet (see Figure 3.19) contains the calculation control parameters. Keep the default settings in the **Iterative procedure** box and keep the number of **Additional steps** to 250. Also check that the option **Reset**
displacements to zero is selected (default in the phase following the Initial phase).

- The calculation parameters for the first phase have now been set. Click OK to close the Phases window. A window pops up asking whether the element and load settings need to be copied from the previous phase. In general click Yes in order to start from the same conditions as in the previous phase.

- Back in the main window of the Input program, the Phase list combo box will show ‘Excavation’. The draw area can now be used to define the construction stages for the current project. To do this, follow these steps:

  - Select the work plane at \( y = 0.0 \) m from the Active work plane combo-box.
  - Click on the geometry line corresponding to the basement wall. This should activate the basement wall. An active wall is coloured blue, an inactive wall is coloured grey.
  - Also click on the soil cluster enclosed by the walls. A dialog will appear, including a tick box, which allows you to switch off the Soil below. Click on the tick box to switch off the cluster. It is not necessary to switch off the water, since the water starts at the level \( y = -2.0 \) m, which is just below the excavation. Click OK to close the dialog. The cluster will now be coloured white, to indicate it is switched off.
  - Now select the work plane at \( y = -2.0 \) m.
  - Click on the floor to activate it. A dialog will appear, including a set of check boxes (see Figure 3.20). Click on the check box in front of Floor to switch on the floor. Click OK to close the dialog box. The floor should be coloured dark green (olive), indicating it is active.

  ![Figure 3.20 The Select items window with the floor element activated](image)

This completes the calculation definition for the first phase. To define the second calculation stage, follow these steps:

  - Click the Next phase button to define the second calculation phase. The Phases window will open and the next phase is selected, named Phase 2 by default.
In the General tab sheet, change the name to ‘Loading’. Make sure this phase starts from Phase 1 ‘Excavation’.

In the Parameters tab sheet, make sure that the option Reset displacements to zero is not checked.

Keep the default parameters for the other options and close the Phases window.

Click Yes to copy the settings from the previous phase.

Make sure Phase 2 ‘Loading’ is selected in the Phase list and the work plane at $y = -2.0$ m is still selected.

Double click the grey circle indicating the inactive point load at (-10.0, -3.0). This will open a Point load window, where the magnitude and direction of the load can be entered. Enter load $y = -6000$ kN (6000 kN acting in the downward y-direction) and click OK. Make sure the load is active, indicated by a blue circle. If necessary, the load can be activated or deactivated by clicking once on the load.

Repeat this action for all point loads, so they all have a $y$-value of -6000 kN.

Click the Preview button to check the definition of the calculation stages. The preview option enables a direct visual check of the situation to be calculated before the calculation is started. The preview should show the excavated basement with walls and the activated loads acting on the basement floor. If the loads are not visible, the geometry can be rotated using the arrow keys on the keyboard. Also make sure the Loads option is selected from the Geometry menu.

Figure 3.21 Preview of the geometry and the activated loads
• After the preview click the Close button to return to the main window. If the situation is unsatisfactory, click the Close button and correct the situation in the main window. The calculation definition is now fully complete.

• If graphical output in the form of load-displacement curves is required, the ‘select points for curves’ button should be used. In this case this is not necessary, and the calculations can be started directly.

Click the Calculate button. This will start the calculation process.

All calculation phase that are marked for calculation, as indicated by a blue arrow (three phases in this case) will, in principle, be executed in the order controlled by the Start from phase parameter.

During the execution of a calculation a window appears which gives information about the progress of the actual calculation phase (see Figure 3.22). The information, which is continuously updated, shows amongst others the calculation progress, the current step number, the global error in the current iteration and the number of plastic points in the current calculation step. It will take several minutes to perform the calculation. When a calculation ends, the window is closed and focus is returned to the main window. Also, the Phase list is updated, showing a green tick mark to indicate that the calculation was finished successfully.

![Figure 3.22 The calculations information window](image)

**Hint:**

In the Professional Version calculation phases may be added, inserted or deleted using the Next, Insert and Delete buttons in the Phase list window. Check the list of calculation phases carefully after each execution of a (series of) calculation(s). A successful calculation is indicated in the list with a green tick mark (✓) whereas an unsuccessful calculation is indicated with a red cross (✗). Calculation phases that are selected for execution are indicated by a blue arrow (→) and deactivated calculation phases by a white arrow.
3.4 VIEWING OUTPUT RESULTS

Once the calculation has been completed, the results can be evaluated in the Output program. In the Output program the displacement and stresses in the full 3D model as well as in the individual work planes or structural elements can be viewed. The computational results are also available in tabular form. To view the results for the current analysis, follow these steps:

Select the last calculation phase (Loading) in the Phase list combo box.

Note that the Calculate button has changed into an Output button. Click the Output button to open the Output program. The Output program will by default show the 3D deformed mesh at the end of the selected calculation phase. The deformations are scaled to ensure that they are clearly visible.

- Select Total displacements from the Deformations menu. The plot shows the total displacements of all nodes as arrows, with an indication of their relative magnitude.

- The presentation combo box in the toolbar currently reads Arrows. Select Shadings from this combo box. The plot shows colour shadings of the total displacements (see Figure 3.23). A legend is presented with the displacement values at the colour boundaries. In case the floor is shown this will partially hide the displacements of the soil. In order to obtain the plot shown below, switch off the floor by selecting the Structures option from the Geometry menu.

![Figure 3.23 Shadings of total displacements](image)

Figure 3.23 Shadings of total displacements
**Hint:** The arrow keys may be used to change the orientation of a 3D model on the screen. By default, the orientation is such that the positive x-direction is to the right, the positive y-direction is upwards and the positive z-direction is towards the user. The ← and → keys may be used to rotate the model around the y-axis whereas the ↑ and ↓ keys may be used to rotate the model in its current orientation around the horizontal screen axis.

- Select *Contour lines* from the presentation combo box in the toolbar. The plot shows contour lines of the total displacements. A legend is presented with the displacement values corresponding to the labels.

Apart from the entire 3D geometry, output can also be obtained at the work planes. The work planes can be selected using the tabs at the top of the output window. Each tab corresponding to a work plane is labeled by the y-coordinate of the work plane. The right-most tab, labeled 3D, will show the 3D geometry view.

- Select the middle work plane ($y = -2.0$) by clicking the second tab. The plot now shows contours of total displacements in the work plane with labels corresponding to the index.

**Hint:** In addition to the *Total displacements*, the *Deformations* menu allows for the presentation of *Incremental displacements* and *Phase displacements*. The incremental displacements are the displacements that occurred in one calculation step (in this case the final step). Incremental displacements may be helpful in visualising failure mechanisms. Phase displacements are the displacements that occurred in one calculation phase (in this case the last phase). Phase displacements can be used to inspect the impact of a single construction phase, without the need to reset displacements before starting the phase.

- In the *Geometry* menu, reactivate the *Structures*.

- When the middle plane is active, double click on the floor plate. This will open a new window, showing the deformed plane of the floor. Select *Bending moments M11* from the *Forces* menu to show the bending moments over the longest direction in the floor plate. If the floor is not visible, it cannot be selected. Therefore it is necessary to select the *Structures* option from the *Geometry* menu first.

To view the bending moments in tabulated form, click the Table button. A new window is opened in which a table is presented, showing the values of bending moments in each node of the floor.
Figure 3.24 Shadings of bending moments in the floor plate
In this lesson a load test on a bored pile will be simulated. During a full scale field test in Brazil, a total of 6 piles were tested (das Neves, 2001). The diameter of the piles ranged from 35 to 50 cm and they were loaded in compression as well as tension. The piles were monitored using extensometers as well as load cells.

One of the piles was a 40 cm diameter pile with a length of 10 m, which was ultimately loaded to failure in compression. It has been constructed in a homogeneous subsoil consisting of clayey sand, as sketched in Figure 4.1. The water table is located just below the foot of the pile.

The purpose of the analysis is to demonstrate the general set-up of a 3D model including piles modelled as volumetric elements. In order to restrict the calculation time needed, the model is rather coarse, but it will show the load-settlement behaviour of a bored pile. The mesh is too coarse however, to reliably predict the bearing capacity of the pile.

### 4.1 GEOMETRY

The pile is placed at the centre of a small excavation with a depth of 1.20 m. The top of the pile extends 60 cm above the bottom of the excavation. The water table is located at a depth of 10.6 m below the original soil surface. In order to avoid any influence of the boundaries, the model is extended 10 m below the pile toe and 10 m to all sides.

---

To create the geometry and finite element mesh, follow these steps:

**General settings**

- Start the Input program and select *New project* from the *Create/Open project* dialog box.
- In the *Project* tab sheet of the *General settings* window, enter an appropriate title for the project and keep the other settings to their default.
- In the *Dimensions* tab sheet, keep the standard units (*Length* = m, *Force* = kN, *Time* = day) and enter for the dimensions *Xmin* = -10, *Xmax* = 10, *Zmin* = -10 and *Zmax* = 10. In the *Grid* box enter *Spacing* = 1 m and *Number of intervals* = 2.
- Click the *OK* button and the draw area appears.

**Work planes**

- Open the *Work planes* window. Add 2 new work planes. In addition to the default work plane at *y* = 0.0 m, assign values of *y* = -10.6 and -20.6 m to work planes. To do this, click in the table of work plane levels and type the desired value.
- Click *OK* to close the work plane window.

**Pile geometry**

- Make sure the work plane *y* = 0.0 m is selected. Select the *Pile* tool and the *Pile designer* will appear (see Figure 4.2). Select a *Circular tube* for the *Pile type* and set the *Diameter* to 0.4 m.
- Click the material sets button in the pile designer.
- Select the existing data set and click *Edit*. Enter the properties as shown in Figure 4.3.
- Close the data set and drag it on the graphical pile tube in the pile designer. The circular tube should turn blue.
- Click *OK* to close the *Material sets* window.

A pile is composed of different *Sections*. A section can be a circular *Arc* or a straight *Line*. Using the left and right arrows at the bottom right of the *Section* box, one can switch between the different sections. Alternatively, clicking on a section in the preview of the pile will select the clicked section.

- Leave the *Angle* for each section of the pile to the default value of 60 °.
- Click *OK* to close the *Pile designer*. 
• The cursor is now shaped as a pile to indicate that the pile is about to be placed in the geometry. The position of the pointer corresponds with the axis of the pile. Move the cursor to (0,0) and click once. The pile is now placed in the geometry between the active work plane and the work plane just below it.

• Insert two work planes at \( y = -1.2 \) and \(-0.6\).

Figure 4.2 Pile designer

Figure 4.3 Wall properties of the pile tube
**Hint:** The point where the pile is inserted in the work plane is called the Pile reference point. An existing pile may be edited by double clicking the pile reference point. As a result, the pile designer appears in which the existing pile is presented.

**Excavation around the pile cap**

During the pile load test, a small excavation is used to make the pile cap more accessible. To model this excavation, an additional cluster must be defined. To draw this cluster, first zoom in around the pile.

- Select Zoom in from the toolbar. Click on (-2.0, -2.0) and hold the mouse button down. Now drag the mouse to (2.0, 2.0) and release the mouse button. This will zoom to the area directly around the pile.
- Select the Geometry line tool.
- Draw a square cluster around the pile with coordinates (-1.0, -1.0) - (-1.0, 1.0) - (1.0, 1.0) - (1.0, -1.0) and click on (-1.0, -1.0) again to close the cluster. Right-click to end drawing new geometry lines.

**Load**

In order to simulate the load test, a point load must be added on top of the pile. As the pile is constructed to a level slightly below the soil surface, follow these steps to add the load to the correct level:

- First change the Active work plane to \( y = -0.6 \) m.
- Select the Floor and click inside pile to drop the floor at the top of the pile in order to close it.
- Click the material sets button and select Floor as set type.
- Select the existing floor data set and click Edit.
- Enter the floor properties as shown in Figure 4.4 and close the data set.
- Drag the floor data set to the floor and drop it there. It may be necessary to move the material sets window. The floor will change colour (light green to dark green) to indicate that the properties have been assigned properly.
- Close the material data set window.
- Add an additional geometry line from (0.0, 0.0) to (0.0, 1.0)
- Select the Point load tool and add a load at the centre of the pile. Click once on (0, 0) to add a point load.
- Select Reset View from the View menu.
Figure 4.4 Floor properties of the pile top

**Borehole and material properties**

In order to define the soil layer, a borehole needs to be added and the properties of the clayey sand must be assigned.

- Click the *Borehole* tool button and add a borehole to (-5.0, 0.0)

Figure 4.5 The Borehole window

- Check in the column Y [m] that the y-coordinate of the top layer boundary is set to 0.0 m and the bottom is set to -20.6 m.
Enter a value of $y = -10.6$ for the Water level.

Click on the material sets button and enter the properties of the clayey sand as listed in Table 4.1.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Clayey Sand</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td>-</td>
</tr>
<tr>
<td>Material behaviour</td>
<td>Type</td>
<td>Drained</td>
<td>-</td>
</tr>
<tr>
<td>Unsaturated soil weight</td>
<td>$\gamma_{\text{unsat}}$</td>
<td>16.7 kN/m$^3$</td>
<td></td>
</tr>
<tr>
<td>Saturated soil weight</td>
<td>$\gamma_{\text{sat}}$</td>
<td>16.7 kN/m$^3$</td>
<td></td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>$E$</td>
<td>9150 kN/m$^2$</td>
<td></td>
</tr>
<tr>
<td>Poisson’s constant</td>
<td>$\nu$</td>
<td>0.3</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion</td>
<td>$\gamma$</td>
<td>13 kN/m$^2$</td>
<td></td>
</tr>
<tr>
<td>Friction angle</td>
<td>$\phi$</td>
<td>26 $^\circ$</td>
<td></td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$\psi$</td>
<td>0 $^\circ$</td>
<td></td>
</tr>
<tr>
<td>Interface reduction factor</td>
<td>Rinter</td>
<td>1</td>
<td>-</td>
</tr>
</tbody>
</table>

Assign the material properties to the soil layer by drag and drop in the borehole window.

Click OK to close the material set window.

In the Borehole window switch to the Soil tab and check that the $K_0$ values for clayey sand are set to 0.562.

Click OK to close the Borehole window.

**2D Mesh generation**

When a pile element is included in the geometry model, an automatic local refinement will be performed by the program around the pile contour. For this exercise, an additional local refinement is necessary. To generate an appropriate mesh, follow these steps:

- Click the *Generate 2D mesh* button. A few seconds later the mesh is presented in the Output window. Inspect the mesh and click the *Update* button to return to the Input program.
- Back in the Input program, select the cluster around the pile, representing the excavation. From the Mesh menu, select *Refine cluster*. The Output window will re-appear, showing a mesh refinement around the pile. Return to the Input program and refine the excavation cluster once more.
3D Mesh generation
The generation of the 3D mesh is straightforward.

- Click the *Generate 3D mesh* button. This will present the Output program once more, now showing a three-dimensional view of the generated mesh. Click the *Update* button to return to the geometry input mode.

- Click on the *Calculation* button to proceed to the calculation mode. Save the project under an appropriate name.

4.2 DEFINING CALCULATION STAGES

In the calculations, three stages will be considered. They are the generation of initial conditions, the construction of the pile and the loading of the pile. The calculation stage defining the initial conditions is already created automatically as a gravity loading phase. In order to change this phase to a $K_0$ procedure and generate initial stresses, follow these steps:

- Open the *Phases* window and change the calculation type for the initial phase to $K_0$ procedure (see Figure 4.6).

![Figure 4.6 The Phases window with the Parameters tab sheet for the $K_0$ procedure](image)

- On the Parameters tab, check that the $K_0$ value is 0.562.

To define the other two calculation stages, follow these steps:
**Construction of the pile**

- Double click the second phase (*Phase 1*) to activate it.
- Leave the settings for the *Iterative procedure* on their *Default* values.
- Click *OK* to close the window.
- Click *Yes* to copy the settings from the previous phase.
- Check that in the *Phase list* Phase 1 is selected.
- Select the work plane \( y = -0.6 \) m from the *Active work plane* list.
  
  Click on the pile tube to activate it. The pile tube should turn blue. It may be necessary to zoom in on the pile in order to properly select the cluster representing the pile. Use the Zoom in button on the toolbar for this purpose.
- Click on the soil cluster inside the pile. A *Select items* window will appear.
- Click the checkbox *Floor* to activate the floor. Deselect *Soil above*.
- Click *OK* to close the *Select items* window.
- Click on the cluster around the pile, which will be excavated during pile Construction. In order to simulate the excavation, switch off both the *Soil above* and the *Soil below* by removing the tick mark in the *Select* window.
- Click *OK* to return to the Input program.

The pile has now been activated only between the work plane \( y = -0.6 \) and the first work plane \( y = -1.2 \) m below it. In order to activate the remainder of the pile:

- Change the active work plane to \( y = -1.2 \) m.
- Click on the pile tube to activate it. The first calculation phase has now been defined.

**Hint:** To check whether the calculation stage has been defined correctly, click the *Preview* button. This will present a 3D view of the geometry. This can be used to check which clusters and objects are active.

**Pile loading**

- Click the *Next phase* button to open the *Phases* window and to define *Phase 2* (see Figure 4.7). On the *Parameters* tab sheet, check that the option *Reset displacements to zero* is *not* checked. Close the window and click *Yes* to copy the settings.
- Select the work plane \( y = -0.6 \) as the active work plane.
- Double click the point load at the centre of the pile to activate it. Select *Point load* from the select window. A window will open, allowing you to change the
direction and magnitude of the force. Enter a force of -800 kN in the y-direction.

- Click OK to close the window and return to the input program. This completes the definition of the calculation phases.

Figure 4.7 Iterative procedure settings window

Figure 4.8 Select a point (A) on the pile for curves
Before starting the calculation, select the node at the top of the pile, in order to be able to plot the load displacement curve later on.

Click the Select points for curves button to open the Output program. All nodes present in the geometry are drawn. Click Structures in the Geometry menu to hide the structures in the window and select the node on top of the pile at (0, 0) in the work plane \( y = -0.6 \) m (see Figure 4.8). It may be necessary to zoom into the area around the pile in order to select the correct point. Click Update to return to the input program.

4.3 CALCULATION

The geometry and calculation stages have now been defined and the calculation can be started.

Press the Calculate button to start the calculation.

The calculation process should now start. The program starts from the first calculation phase marked for calculation, which is the Initial phase. At the end of the calculation all phases should be indicated by a green tick mark, which indicates that they have been successfully calculated.

After the calculation, click the Save button to save the project. This is required for the creation of load-displacement curves.

4.4 VIEWING OUTPUT RESULTS

After the calculations, the results of the load test can be viewed by selecting a calculation phase from the Phase list and pressing the Output button. The Output button replaces the Calculate button after the calculation has finished.

- Select the final calculation phase (Phase 2) and click the Output button. The Output program will open and show the deformed mesh at the end of the load test. The stresses and deformations in the work planes can be viewed by clicking on the corresponding tabs and selecting the desired output from the menu. For example select the work plane \( y = -10.6 \) to investigate the stresses around the pile tip (see Figure 4.9).

In order to evaluate stresses and deformations inside the geometry, select the Cross section tool. A top view of the geometry is presented. For the load test a cross section through the pile is most interesting. Draw a cross section from left to right across the geometry through the origin. A vertical cross section is presented. This cross section can be rotated in the same way as a regular 3D view of the geometry. Select Vertical displacements from the Deformations menu and select Shadings from the presentation combo box (see Figure 4.10).
Figure 4.9  Relative shear stresses around the pile tip in work plane \( y = -10.6 \)

Figure 4.10  Cross section of vertical displacements

For the load test a load-displacement curve of the pile can be plotted in the Curves program:

- Start the Curves program by clicking on the corresponding button on the upper left side of the toolbar.
• Click OK to create a New chart.
• Select the pile load project and press the Open button.
• In the Curve generation window, select for the x-axis the Multiplier option and From the Type combo box, select Sum-Mstage.
• For the y-axis, select Displacement and select the vertical displacement $u_y$ as Type Check that the point at the top of the pile is selected in the Point combo box, this should be Point A (0.0 / -0.6).
• Click OK to generate the graph.

The graph will now show the vertical displacements against $\Sigma$-Mstage. $\Sigma$-Mstage is a parameter that signifies the amount of load unbalance in the current calculation phase already solved. It will increases from 0 at the beginning of a calculation phase to 1 at the end of the phase, if the calculation completes successfully. For the last phase, the value of $\Sigma$-Mstage corresponds to the amount of the applied point load of 800 kN actually being activated. To plot only this part of the load displacement curve, follow these steps:

• Right click in the graph and select Format from the pop-up menu. Select Curve from the submenu that appears. Alternatively select Curve from the Format menu.
• Click the Phases button on the top right of the Curves settings window to show the Select phases window.
• In the Select phases window, remove the tick mark before Initial Phase, Phase 3 and Phase 4 leaving only Phase 2. Click OK to close the window and click OK once more to update the graph.

The graph will now show only the displacement resulting from the loading of the pile (see Figure 4.11). The value $\Sigma$-Mstage = 1 in the graph corresponds to a load of 800 kN.
5 A-SYMMETRIC RAFT FOUNDATION (LESSON 3)

This lesson describes the construction and subsequent loading of a T-shaped raft foundation on sand and clay layers. The geometry and dimensions of the raft foundation are presented in Figure 5.1. It consists of a 20 cm thick roughly T-shaped concrete floor on which 3 m high concrete walls have been cast.

![Figure 5.1 Geometry and dimensions of the T-shaped raft foundation](image)

Figure 5.1 Geometry and dimensions of the T-shaped raft foundation

![Figure 5.2 Cross-section of raft foundation: presentation of the soil layers](image)

Figure 5.2 Cross-section of raft foundation: presentation of the soil layers
This raft foundation is constructed on a 2 m thick sand layer laying on top of a 20 m thick clay layer, as shown in Figure 5.2. Construction of the raft and wall is expected to take 30 days after which the structure is loaded with a distributed load $q_y = -10 \text{kN/m}^2$ distributed over the floor and a line load $p_y = -400 \text{kN/m}$ acting along the top of the walls.

5.1 INPUT

The proposed geometry for this exercise is 50 m wide and 30 m long. The foundation is 15 m long and 8 m wide and is placed in the centre of the geometry.

**General settings**

To enter the geometry for this exercise, follow these steps:

- Start the Input program and select *New project* from the *Create/Open project* dialog box.
- Enter an appropriate title for the exercise and set the model dimensions to $x_{\text{min}} = 0 \text{m}$, $x_{\text{max}} = 50 \text{m}$, $z_{\text{min}} = 0 \text{m}$, $z_{\text{max}} = 30 \text{m}$. Keep the default settings for the units and the grid spacing.
- Click *OK* and the draw area should appear.

**Work planes**

- In addition to the predefined work plane at $y = 0.0 \text{m}$, add three work planes at respectively $y = 3.0 \text{m}$, $y = -2.0 \text{m}$ and $y = -22.0 \text{m}$.
- Click *OK* to close the *Work planes* window.

**Geometry**

In the work plane $y = 0 \text{m}$, we will first create the geometry of the concrete floor.

- Select the *Geometry line* tool.
- Draw a cluster with the following corner points (22.0, 13.0), (22.0, 11.0), (30.0, 11.0), (30.0, 19.0), (22.0, 19.0), (22.0, 17.0), (15.0, 17.0), (15.0, 13.0). Click on (22.0, 13.0) again to close the cluster. Right-click to end drawing new geometry lines.
- Select the *Floor* option from the geometry toolbar.
- Click anywhere within the area enclosed by the previously created lines. This area should now be coloured olive (green), indicating that a floor has been added.
- Change the work plane to $y = 3 \text{m}$. 
Select the *Wall* option and add walls to the geometry with corner points at (24.0, 13.0), (27.0, 13.0), (27.0, 17.0), (24.0, 17.0). Once again right-click to end drawing new walls.

**Loads**

After the geometry of structural elements has been defined, the loads acting on both the floor and the walls have to be defined:

- Select the *Distributed load (horizontal planes)* option from the toolbar.
- Add a load to the two clusters representing the concrete floor at work plane $y = 0$ m.
- Select the *Line load* option.
- Add a line load at the location of the 4 walls in the work plane at $y = 3$ m by clicking on the four existing corner points of the wall. By default the line load has a value of 1 kN/m and is acting perpendicularly to the walls. Leave these at their default value for now.

**Borehole**

As all soil layers for this exercise are horizontal, only a single borehole is needed (see Figure 5.3).

- Add a borehole to the geometry at (0.0, 30.0) and insert 1 additional layer boundary. Enter the layer boundary levels according to Figure 5.2.
- Set the water level to $y = -2.0$ m.
- Open the *Material properties* window. Due to the limitations of the Introductory Version only one data set can be created. Select the existing data set and enter the properties given in Table 5.1. Assign the data set to both soil layers and close the material database.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Clay</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Hardening Soil</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Undrained</td>
<td>-</td>
</tr>
<tr>
<td>Soil weight above phreatic level</td>
<td>$\gamma_{unsat}$</td>
<td>17</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Soil weight below phreatic level</td>
<td>$\gamma_{sat}$</td>
<td>18</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Permeability</td>
<td>$k_x$, $k_y$, $k_z$</td>
<td>$4\cdot10^{-4}$</td>
<td>m/day</td>
</tr>
<tr>
<td>Triaxal stiffness</td>
<td>$E_{50}^{ref}$</td>
<td>5000</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Oedometer stiffness</td>
<td>$E_{oed}^{ref}$</td>
<td>3000</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Parameter</td>
<td>Name</td>
<td>Clay</td>
<td>Unit</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------</td>
<td>------</td>
<td>----------</td>
</tr>
<tr>
<td>Poisson’s ratio (advanced parameters)</td>
<td>$\nu$</td>
<td>0.2</td>
<td>-</td>
</tr>
<tr>
<td>Unloading / reloading stiffness</td>
<td>$E_{ur}^{ref}$</td>
<td>20000</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Reference pressure (adv.parameters)</td>
<td>$p^{ref}$</td>
<td>100</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Power</td>
<td>$m$</td>
<td>0.8</td>
<td>-</td>
</tr>
<tr>
<td>Cohesion</td>
<td>$c_{ref}$</td>
<td>3</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Friction angle</td>
<td>$\phi$</td>
<td>29</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>$\psi$</td>
<td>0</td>
<td>°</td>
</tr>
<tr>
<td>Interface reduction factor</td>
<td>$R_{inter}$</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Lateral earth pressure coeff.</td>
<td>$K_0$</td>
<td>0.515</td>
<td>-</td>
</tr>
<tr>
<td>Failure ratio (adv.parameters)</td>
<td>$R_f$</td>
<td>0.9</td>
<td>-</td>
</tr>
</tbody>
</table>

- In the *Soil* tab sheet of the *Borehole* window enter $OCR = 1.2$ and $K_0 = 0.568$ for both soil layers.
- Click *OK* to close the borehole.

![Figure 5.3 The Borehole Window](image)

*Floor and walls material properties*

To enter the floor and walls material properties, follow these steps:

- Open the material sets window and select *Floors* as the set type.
• Double click the existing material set to change it.
• Change the name of the data set to Floor and enter the material parameters given in Table 6.
• Select the work plane $y = 0.0$ m and drag the Floor data set to the clusters representing the concrete floor and drop it there. It is necessary to repeat the operation twice in order to assign the data set to the entire floor. The walls should get a dark green colour.
• Change the material set Type to Walls.
• Select the existing data set and click Edit.
• Name the data set Walls and enter the material parameters given in Table 5.3.
• Change the work plane to $y = 3$ m and assign the Walls data set to the four wall elements visible in this work plane. The walls should get a blue colour.

### Table 5.2 Material properties for the floor

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Linear, isotropic</td>
<td>-</td>
</tr>
<tr>
<td>Thickness</td>
<td>$d$</td>
<td>0.20</td>
<td>m</td>
</tr>
<tr>
<td>Volumetric weight</td>
<td>$\gamma$</td>
<td>24</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>$E_i$</td>
<td>$3.0 \cdot 10^7$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>$G_{ij}$</td>
<td>$1.304 \cdot 10^7$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>$\nu_{ij}$</td>
<td>0.15</td>
<td>-</td>
</tr>
</tbody>
</table>

### Table 5.3 Material properties for the walls

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Linear, isotropic</td>
<td>-</td>
</tr>
<tr>
<td>Thickness</td>
<td>$d$</td>
<td>0.3</td>
<td>m</td>
</tr>
<tr>
<td>Volumetric weight</td>
<td>$\gamma$</td>
<td>24.0</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>$E_i$</td>
<td>$3.0 \cdot 10^7$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>$G_{ij}$</td>
<td>$1.304 \cdot 10^7$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>$\nu_{ij}$</td>
<td>0.15</td>
<td>-</td>
</tr>
</tbody>
</table>

### Mesh generation

The mesh for this example will be of medium coarseness, with a further refinement of the floor clusters. To generate this mesh, follow these steps:

• From the Mesh menu, select Global settings and set the element distribution to Medium. Select the two clusters of the concrete floor. Hold down the <Shift> key to select multiple clusters.
• Choose *Refine cluster* from the *Mesh* menu and the Output program will show the generated mesh.

• Return to the main draw area and generate the 3D mesh (see Figure 5.4). Click *Update* to return to the main draw area.

• Switch to the Calculation mode and save the project under an appropriate name.

![Figure 5.4 Preview of the generated 3D mesh](image)

### 5.2 CALCULATIONS

The calculation consists of 4 phases. The initial phase will consist of the generation of initial stresses using the *K0 procedure*. The following phases will consist of the installation of the floor and walls (which is assumed to last 30 days) and the subsequent loading of the structural elements. The fourth phase will consider the consolidation of the soil layers until all excess pore pressures are dissipated.

• Open the *Phases* window and change the *Calculation type* for the first phase to *K0 procedure*. In the *Parameters* tab, check that the *K0* and *OCR* values correspond with the values as entered in the *Soil* tab of the *Borehole* window (*OCR = 1.2* and *K0 = 0.568*).

• Double click Phase 1 to activate it. Leave the calculation type as *Plastic* and enter a time period of 30 days in the *Time interval* edit box of the *Parameters* tab sheet. Close the *Phases* window (copy settings).

• Close the *Phases* window and activate all walls along with the complete concrete floor in this phase. This second phase will simulate the casting of the structural elements over a time period of 30 days.
• Activate the third phase and set the *Time interval* to 1 day.

• In the work plane $y = 3 \text{ m}$, click the line load on one of the 4 wall elements. Activate the *Line load* in the *Select items* window that appears and click the *Change* button.

• In the *Line load* window, set the $y$-values to -100 and all $x$- and $z$-values to 0. This indicates a load of 100 kN/m, acting in the negative $y$-direction. Repeat the operation for each individual wall.

• In the work plane $y = 0 \text{ m}$, click the distributed load. Activate the *Distributed load* in the *Select items* window that appears and click the *Change* button.

• In the *Distributed load* window, set the $y$-values to -10 and all $x$- and $z$-values to 0. This indicates a load of 10 kN/m, acting in the negative $y$-direction. Repeat this procedure for the other cluster.

• Activate Phase 3. Change the calculation type to *Consolidation* and set the *Loading input* to *Minimum excess pore pressure*. Set $|P\text{-stop}|$ to 1 kN/m$^2$.

• Click *OK* to close the *Phases* window.

This completes the definition of the calculation phases. Before starting the calculation, select the node at one of the floor vertices in order to be able to plot the load displacement curve later on.

Click the *Select points for curves* button to open the Output program. All nodes of present in the geometry are drawn. Select the node on the corner of the floor at $(22, 11)$ in the work plane $y = 0.0 \text{ m}$. It may be necessary to zoom into the area around the raft in order to select the correct point (see Figure 5.5).

![Figure 5.5](image)

Figure 5.5 Location of selected corner point for curves

• Close the output program to return to the input program.
• Click on Calculate to run the calculation. After the calculation save the project.

5.3 OUTPUT

The deformation of the soil after construction and loading of the structure, and before consolidation, can be investigated as follows:

• Select the phase in which the loads are applied, named Phase 2.
• Click the Output button to access results of this phase in the Output program (see Figure 5.6).

It is also possible to assess the bending moments within the concrete floor at this stage. To display these results:

• Select the work plane $y = 0.0$ and double-click on the floor,
• In the Force menu, select the Bending Moments $M_{11}$ output item
• Select Shadings option in the combo box of the Menu bar (Figure 5.7).
Figure 5.7 Bending moments in the concrete floor at the end of Phase 2

- Start the Curves program by clicking on the corresponding button on the upper left side of the toolbar.
- Click OK to create a New chart.
- Select the Lesson 3 project and click the Open button.

**Hint:** In case a message appears telling that no data is available, go back to the Input window and save the project.

- In the Curve generation window (Figure 5.8), select for the x-axis the Time option.

Figure 5.8 Setting up the time-displacement curve
• For the y-axis, select *Displacement* and select the vertical displacement $u_y$ as *Type*. Check that the point at corner of the floor is selected in the *Point* combo box, this should be Point A (22.0 / 0.0 / 11.0).

• Click *OK* to generate the graph (Figure 5.9).

![Figure 5.9 Time - displacement curve over calculation phases](image)

Figure 5.9 Time - displacement curve over calculation phases
6 LOAD CAPACITY OF A SUCTION PILE (LESSON 4)

In this lesson the load capacity of an off-shore foundation will be considered. A suction pile is a hollow steel pile of large diameter, with a closed top, that is installed in the seabed by pumping water from the inside. The resulting pressure difference between the outside and the inside is the driving force that installs the pile in the soil. The installation process itself will not be modelled. This exercise will investigate the load capacity of the anchor after installation. Three different angles of the pull out force will be considered. The geometry for the problem is sketched in Figure 6.1.

![Figure 6.1 Geometry of the suction pile (not to scale)](image)

6.1 GEOMETRY

The suction pile is a hollow steel tube, which is 6 m long and 2 m in diameter. The anchor line is attached on the side of the pile, 1.5 m from the top. It has been installed in a seabed, consisting of medium dense sand. The local water depth is 50 m. An area 40 m wide and 40 m long surrounding the suction pile will be modelled. With these dimensions the model is sufficiently large to allow for any possible collapse mechanism to develop and to avoid any influence from the model boundaries. The bottom of the model is taken 12 m below the seabed.

The installation of the suction pile will be modelled in a single calculation phase. The interaction between the steel pile and the soil will be modelled using an interface, allowing for the reduced friction between the steel surface and the soil. The pull out force from the anchor line is modelled by means of a point load on the suction pile surface, which is applied after the installation phase.

General settings

To enter the geometry for this exercise, follow these steps:

- Start the Input program and select New project from the Create/Open project dialog box.
Enter an appropriate title for the exercise and set the model dimensions to $x_{\text{min}} = 0 \text{ m}$, $x_{\text{max}} = 40 \text{ m}$, $z_{\text{min}} = 0 \text{ m}$, $z_{\text{max}} = 40 \text{ m}$. Keep the default settings for the units and the grid spacing.

Click OK and the draw area should appear.

**Work planes and pile geometry**

First create a work plane equal to the bottom level of the pile. To do this, follow these steps:

- Select work planes from the toolbar and *Add* a work plane. Now select the lowest work plane in the list and change the $y$-level to -6.0 m.
- Close the work plane dialog.
- Select the work plane at $y = 0.0 \text{ m}$.
- Click the *Pile* button on the toolbar to open the *Piles* dialog.
- Accept the default setting for the pile type: *Circular tube* in order to create a hollow steel pile.
- Leave the thickness of the pile to 0.0, as the steel pile will be modelled as a shell element only. Change the diameter to 2 m.
- Make sure the options *Shell*, *Outside interface* and *Inside interface* are all checked.
- Select *Section 1* of the pile and change the *Angle* to 45°. Proceed to *Section 2* and also change the angle to 45°. Proceed to *Section 3*. Note that the *Angle* has automatically increased from the default angle of 60° to 90° as a result of the changes in sections 1 and 2. Change the angle for section 3 also to 45°. A new section is automatically added to complete the circle.
- Now all 4 (8) sections should have a 45° angle, and should all have a shell, an inside interface and an outside interface present. Click *OK* to close the pile designer.
- Select the work plane at $y = 0.0 \text{ m}$. Move the cursor to (20.0, 20.0) and click once to place the pile in the geometry model.

**Anchor Load**

To introduce the anchor load 1.5 m below the top of the suction pile, another work plane is needed. To add the load, follow these steps:

- Open the work plane dialog and select the lowest work plane ($y = -6.0 \text{ m}$)
- Click *Insert* to add a new work plane. A new work plane will appear at $y = -3.0 \text{ m}$.
- Click on the work plane level and change it to $y = -1.5 \text{ m}$.
LOAD CAPACITY OF A SUCTION PILE (LESSON 4)

Hint: The work plane at \( y = -1.5 \) m was not added earlier, as this would complicate adding the pile. A pile is always added between the current work plane and the one directly below it. Were the work plane at \( y = -1.5 \) already present when we added the pile, the pile would have been only 1.5 m high, instead of the desired 6 m, and a second pile should have been added between -1.5 and -6.0 m.

- Close the work plane dialog.
- Select the work plane at \( y = -1.5 \) m. Select Point load on the tool bar and add a point load at (19.0, 20.0), the leftmost node of the pile.

Boreholes

Select the Borehole tool and add a borehole at (40.0, 10.0). The borehole window will automatically open. Change the bottom of the lowest layer boundary to \( y = -12 \) m.

Open the Material window and select Soil & interfaces as the Set type. Click the Edit button to modify the existing data set.

- Enter Sand for the Identification and select Mohr-Coulomb as the Material model. Enter the properties as listed in Table 6.1 and click OK to close the data set.

Table 6.1 Material properties of the sand and silt layers and their interfaces.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Sand</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Mohr-Coulomb</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Drained</td>
<td>-</td>
</tr>
<tr>
<td>Soil weight above phr. level ( \gamma_{unsat} )</td>
<td>17</td>
<td>kN/m³</td>
<td></td>
</tr>
<tr>
<td>Soil weight below phr. level ( \gamma_{sat} )</td>
<td>20</td>
<td>kN/m³</td>
<td></td>
</tr>
<tr>
<td>Young’s modulus (constant) ( E_{ref} )</td>
<td>( 1.5 \times 10^4 )</td>
<td>kN/m²</td>
<td></td>
</tr>
<tr>
<td>Poisson’s ratio ( \nu )</td>
<td>0.3</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Cohesion (constant) ( c_{ref} )</td>
<td>1.0</td>
<td>kN/m²</td>
<td></td>
</tr>
<tr>
<td>Friction angle ( \phi )</td>
<td>32.0</td>
<td>°</td>
<td></td>
</tr>
<tr>
<td>Dilatancy angle ( \psi )</td>
<td>2.0</td>
<td>°</td>
<td></td>
</tr>
<tr>
<td>Interface strength reduction ( R_{inter} )</td>
<td>0.7</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

- Drag the Sand data set to the soil column (graph) in the borehole and drop it there. Interfaces are automatically assigned to the data set of the corresponding cluster.
- Click OK to close the material sets dialog.
- Enter \( K_0 = 0.47 \).
In the Soil tab change the water level to + 50.0 m above the seabed.

Click OK to close the borehole window.

To model the interaction between the soil and the suction pile, an interface (shown as a dotted line) was created inside and outside the suction pile wall. The interface is modelled in the mesh by *interface* elements.

The interface properties are defined by the parameter $R_{\text{inter}}$ that can be set in the *Interfaces* tab sheet of a soil material set. When the *Interfaces* tab sheet is skipped, the $R_{\text{inter}}$ parameter will have a default value of 1.0 (rigid). The $R_{\text{inter}}$ parameter relates the strength of the interfaces to the strength of the soil, according to the equations:

$$\tan \phi_{\text{inter}} = R_{\text{inter}} \tan \phi_{\text{soil}} \quad \text{and} \quad c_{\text{inter}} = R_{\text{inter}} c_{\text{soil}}$$

With the default value $R_{\text{inter}} = 1.0$ (rigid), $c_{\text{inter}} = c_{\text{soil}}$ and $\phi_{\text{inter}} = \phi_{\text{soil}}$.

In general, strength properties in the interaction zone between soil and structures are lower than the adjacent soil. This reduction can be specified using the $R_{\text{inter}}$ parameter. Hence, using $R_{\text{inter}} < 1.0$ gives a reduced interface friction and adhesion compared to the friction angle and the cohesion in the adjacent soil.

**Suction pile material properties**

To enter material properties for the suction pile, follow these steps:

- Open the material sets window and select *Walls* as the material type.
- Click *Edit* to edit the existing data set. Rename the data set *Suction pile* and enter the material parameters given in Table 6.2.
- Select the work plane $y = 0.0$ and drag the Suction pile data set to the light blue circle representing the suction pile and drop it there. It may be necessary to zoom in around the pile to drop the data set at the correct position.
- Change the work plane to $y = -1.5$ m and also assign the *Suction pile* data set to the wall elements in this work plane. The suction pile should turn blue.

### Table 6.2 Material properties for the suction pile

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Value</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness</td>
<td>$d$</td>
<td>0.15</td>
<td>m</td>
</tr>
<tr>
<td>Volumetric weight</td>
<td>$\gamma$</td>
<td>78.5</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>$E_i$</td>
<td>$2.1 \cdot 10^8$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>$G_{ij}$</td>
<td>$9.545 \cdot 10^7$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>$\nu_{ij}$</td>
<td>0.1</td>
<td>-</td>
</tr>
</tbody>
</table>
Mesh Generation

In order to limit the mesh refinement during mesh generation to the area immediately surrounding the suction pile, an additional soil cluster will be created. In order to do so, follow these steps:

- Select *Geometry line* from the toolbar.
- Draw a cluster with corner points (15.0, 15.0), (25.0, 15.0), (25.0, 25.0) and (15.0, 25.0). Close the cluster by clicking on the first corner and end drawing the cluster.

This completes the geometry definition and material parameters input. In order to generate the mesh:

- Select the cluster directly surrounding the pile.
- Select *Refine cluster* from the *Mesh* menu and click *Update* to return to the main window.
- Refine the cluster once more.
- Select *Generate 3D Mesh* from the toolbar to generate the 3D Mesh.
- Inspect the resulting mesh (Figure 6.2) and click *Update* to return to the main window.

![Figure 6.2 Refining the cluster surrounding the suction pile](image)

- Click the *Calculate* button to switch to calculation mode. Save the problem when prompted.
6.2 CALCULATIONS

The calculation for this exercise will consist of five phases. These are the determination of initial conditions, the installation of the suction pile and three different load conditions.

Initial conditions and suction pile installation

Open the Phases window. Set the calculation type to K0-procedure and check that the $K_0$ values are set to 0.47.

To model the installation of the suction pile, follow these steps:

- Activate the calculation phase called ‘Phase 1’.
- Switch to the Parameters tab sheet and select the Ignore undrained behaviour option.
- Leave all other settings at their default values and click OK to return to the main window (copy settings).
- Select the work plane $y = 0.0$ and click on the wall of the suction pile to activate it. It should be coloured blue, indicating the wall is active.
- Select the work plane $y = -1.5$ m and also activate the suction pile wall in this work plane. Leave the soil inside the suction pile active.

Click the Next phase button to define Phase 2. On the Parameters tab sheet, select the option Reset displacements to zero.

- In the work plane $y = -1.5$ m, double click the point load at (19.0, 20.0). It is represented by a grey circle. Select Point load from the Select window that appears.
- In the Point load window, set the X-value to -1000 and the Y-value to 0. This indicates a load of 1000 kN, acting in the negative x-direction.
- Click OK to close the window. The load should now be represented by a blue arrow. If it is not active (i.e. coloured grey), click once on the point (19.0, 20.0) in order to activate the load.

To add two more load situations, both starting directly after the installation of the suction pile, follow these steps:

- Activate the next calculation phase. On the General tab sheet, set Start from phase to Phase 1. On the Parameters tab sheet, select Reset displacements to zero. Click OK to close the phase list.
- In the draw area, double click on the point load at (19.0, 20.0). Select the point load and enter a load of -866 kN in x-direction and 500 kN in y-direction. This represents a total load of 1000 kN at an angle of 30° with the horizontal.
- Activate another calculation phase. Once more set Start from phase to Phase 1 and Reset displacements to zero.
• Double click the point load and set the force to -500 in x-direction and 866 in y-direction, representing a force of 1000kN at an angle of 60° with the horizontal.

This completes the input of the calculation phases. Before starting the calculation, select some nodes in order to generate curves later on.

Click the Select points for curves button on the toolbar.

• Select the node where the load acts on the suction pile wall. Switch to the work plane $y = -1.5$ m and select the node at (19.0, 20.0).

• If desired, select more nodes and click Update to return to the draw area.

This concludes the input of the calculation phases. To start the calculation:

Click the Calculate button to start the calculation.

### 6.3 VIEWING OUTPUT RESULTS

After the calculation finishes, the results can be viewed by selecting the phase of interest. First, in order to compare the deformation of the suction pile under the different loads, follow these steps:

• Select Phase 2 from the phase list and click the Output button to open the output program. Double click the suction pile (see Figure 6.3).

Select Open File from the toolbar. A file open dialog is shown. From this dialog select the name of the current project. In the lower part of the dialog a list of available phases is shown. Select Phase 3 and click Open to open this phase.
• Repeat these actions for Phase 4.

The output for all three loading phases is now open simultaneously. In order to compare the results visually:

• For each loading phase, click the pile to open output for the pile in a separate window.

• Select *Tile vertically* from the *Window* menu. The results from the three phases will be shown next to each other (see Figure 6.4).

![Figure 6.4](image)

Figure 6.4  Output for three phases tiled vertically (scale factor 10)

• In order to compare the deformations caused by the different scenarios, select one of the windows and select Scale from the Edit menu. This allows you to manually set the scale to a fixed value (for example 10). Repeat this procedure (using the same value) for the other loading phases.
This lesson describes the construction of an excavation pit in clay and sand layers. The excavation pit was constructed as part of a research programme to study the behaviour of sheet pile walls in soft soil as described in detail in Kort (2002). A highly simplified case is presented here, which considers only clay layers. The test pit is a relatively small excavation of 12 by 14 m, excavated to a depth of 7.5 m below the surface. After the full excavation, an additional surface load is added on one side of the pit.

Although the original test pit contained different types of sheet pile elements on the sides of the excavation, only a single type is modelled here.

7.1 INPUT

The proposed geometry for this exercise is 50 m wide and 40 m long, as shown in Figure 7.1. The cross section of the excavation pit with soil layers is shown in Figure 7.2. The excavation pit, 12 m wide by 14 m long is placed in the center of the geometry. An additional cluster for the surface load is needed next to the pit.

After entering the general settings for this exercise, add a work plane at $y = -19.0$ m first. Also change the level of the other work plane to $y = 0.5$ m.

In the work plane $y = 0.5$ m, add the sheet pile walls to the geometry using a single chain of walls. After adding the sheet pile walls, add work planes at $y = -0.5$ m, $y = -5.0$ m and $y = -7.0$ m. Check that the sheet pile walls are present between $y = 0.5$ m and $y = -19.0$ m.

Two beams will be used to model the struts between the sheet pile walls. To add these beams, follow these steps:

Add a beam to the geometry at $y = 0.5$ m using the *Beam* option from the tool bar. Click on (22.0, 14.0) to start the beam. Click on (22.0, 26.0) to add a second point to the beam. Right click to end drawing a beam.

Also add a beam between (28.0, 14.0) and (28.0, 26.0).

A further set of beams will be used to model the walings at the top of the sheet pile walls. In order to add this beam:

Add a beam chain of 4 beams at the same location as the sheet pile walls in the work plane $y = 0.5$ m. Click once on the first corner of the sheet pile walls, click once on the second corner etc, until all four beams are drawn. Then right click to end drawing. Do not right click before, as this will end drawing the beam chain and start drawing a new beam chain.
In the work plane $y = -0.5$ m add a cluster composed of geometry lines to the geometry with corner points (21.0, 6.0), (21.0, 13.0), (29.0, 13.0) and (29.0, 6.0).

Select the Distributed load (horizontal planes) from the toolbar and add a load to the newly added cluster.

**Material properties**

As all soil layers for this exercise are horizontal, only a single borehole is needed. Add a borehole to the geometry and insert 4 additional layer boundaries (see Figure 7.3). The bottom of the lowest layer is at $y = -32$ m.

![Figure 7.3 Borehole with the soil layers and pore pressure distribution](image)

Set the water level to $y = -2.0$ m and open the material properties window.

Enter the data given in Table 7.1 and assign the data set to all layers.

**Table 7.1 Material properties for the soil layers**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Clay</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>MC</td>
<td>-</td>
</tr>
<tr>
<td>Type of material behaviour</td>
<td>Type</td>
<td>Undr.</td>
<td>-</td>
</tr>
<tr>
<td>Soil weight above phreatic level</td>
<td>$\gamma_{\text{unsat}}$</td>
<td>15</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Soil weight below phreatic level</td>
<td>$\gamma_{\text{sat}}$</td>
<td>16</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Permeability</td>
<td>$k_i$</td>
<td>$2 \times 10^{-3}$</td>
<td>m/d</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>$E_{\text{ref}}$</td>
<td>$3 \times 10^3$</td>
<td>kN/m$^3$</td>
</tr>
</tbody>
</table>
Uncheck the *Hydrostatic* check box and change the water pressure at layer boundary 5 to $W_{\text{Press}^+} = -160$ kPa and $W_{\text{Press}^-} = -160$ kPa.

Similarly, change the water pressure at the bottom boundary 6 to -310 kPa.

In the *Soil* tab sheet, enter $K_0 = 0.5$.

Close the borehole window and return to the main draw area.

Create material data sets for the sheet pile walls and beams using Table 7.2 and Table 7.3, and assign them to the structural elements. Take care to assign the material data set for the walls to the wall elements in each of the four work planes between $y = 0.5$ and $y = -19.0$ m.

In creating the material data set for the sheet pile wall, the geometrical orthotropy of the sheet piles and beams is converted into orthotropic Young’s and shear moduli for the wall material data set (see Figure 7.4, Table 7.2, Table 7.3). Using $E_1 = 12 \frac{E_{\text{steel}} I_1}{d^3}$ the moment of inertia of the sheet pile wall as supplied by the manufacturer can be converted to a representative Young’s modulus. Similar relations hold for the other directions. See Chapter 6 of the Material Models Manual for more details and an example for a sheet pile wall.

### Table 7.2 Material properties for the sheet pile walls

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Sheet pile wall</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Linear</td>
<td>-</td>
</tr>
<tr>
<td>Thickness</td>
<td>$d$</td>
<td>0.014</td>
<td>m</td>
</tr>
<tr>
<td>Volumetric weight</td>
<td>$\gamma$</td>
<td>78.5</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>$E_1$</td>
<td>1.8·10$^{11}$</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td></td>
<td>$E_2$</td>
<td>1.8·10$^7$</td>
<td>kN/m$^3$</td>
</tr>
<tr>
<td>Poisson’s ration</td>
<td>$\nu$</td>
<td>0</td>
<td>-</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>$G_{12}$</td>
<td>6·10$^9$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td></td>
<td>$G_{13}$</td>
<td>1·10$^7$</td>
<td>kN/m$^2$</td>
</tr>
<tr>
<td></td>
<td>$G_{23}$</td>
<td>3·10$^7$</td>
<td>kN/m$^2$</td>
</tr>
</tbody>
</table>
Table 7.3 Material properties for the beams

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Beam</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material model</td>
<td>-</td>
<td>Linear</td>
<td></td>
</tr>
<tr>
<td>Cross section area</td>
<td>A</td>
<td>0.020</td>
<td>m²</td>
</tr>
<tr>
<td>Volumetric weight</td>
<td>γ</td>
<td>78.5</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>E</td>
<td>2.1·10⁸</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Moment of Inertia</td>
<td>I³</td>
<td>1.08·10⁻⁴</td>
<td>m⁴</td>
</tr>
<tr>
<td></td>
<td>I₂</td>
<td>9.75·10⁻⁴</td>
<td>m⁴</td>
</tr>
<tr>
<td></td>
<td>I₂₃</td>
<td>0</td>
<td>m⁴</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>ν</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Figure 7.4 Material data set for beams

**Mesh generation**

The mesh for this example will be of medium coarseness, with a further refinement of the excavated clusters. To generate this mesh, follow these steps:

- From the Mesh menu, select *Global settings* and set the *Element distributing* to *Medium*. Select the three clusters of the excavation pit and the cluster of the load area. Hold down the <Shift> key to select multiple clusters. Choose *Refine cluster* from the Mesh menu and the Output program will show the generated mesh.

- Return to the main draw area and generate the 3D mesh (see Figure 7.5). Click *Update* to return to the main draw area.
7.2 CALCULATIONS

The calculation consists of 5 phases. The initial phase will consist of the generation of initial stresses using the $K_0$ procedure. The following phases will consist of the installation of the sheet piles and the subsequent excavation of the pit. The fourth phase will be the application of the additional load next to the pit and the final phase will be a consolidation phase with a length of 300 days.

- Change the Calculation type for the first phase to $K_0$ procedure and check the $K_0$ values as given in Table 7.1.
- Activate the next phase and enter a time period of 7 days in the Time interval edit box of the Parameters tab sheet.
- Close the Phases window and activate all walls and beams in this phase. Take care to activate the walls in all four work planes between $y = 0.5$ and $y = -19.0$. This will simulate the installation of the sheet piles and the struts.
- Click the Next phase button to define the next phase and set the time period to 10 days. This phase will simulate the excavation and dewatering of the pit.
- Select the work plane at $y = -0.5$ m. Select one of the three clusters inside the excavation and deactivate the water below and soil below for this cluster. Repeat this for the other two clusters inside the excavation.
• Change the work plane to \( y = -5.0 \, m \). Select one of the clusters inside the excavation and deactivate the soil clusters between -5 m and -7 m. Then select water below and click on Change to change the pore pressure distribution. In the cluster pore pressure distribution window, select user defined pore pressure distribution and then cluster phreatic level. Set \( y_{ref} \) to -5.0 m. Repeat this for the other two clusters inside the excavation.

• Change the work plane to \( y = -7.0 \, m \). For all three clusters inside the excavation, change the cluster pore pressure distribution for the water below to Interpolate between adjacent clusters or lines.

    Click the Next phase button to define the next calculation phase and set the time period to 2 days. Activate the surface load at \( y = -0.5 \). Set the load to -20 kN/m\(^2\) acting in the downward \( y \)-direction.

• Select an interesting point to create load-displacements curves (e.g. point 25.0, -0.5, 14)

• Start the calculation.

### 7.3 OUTPUT

The deformation and bending moments of the sheet pile wall in the final phase (Phase 3) can be investigated by first opening the output for the final phase.

• Select Phase 3 and click Output to open this phase in the output program.

• Switch to one of the work planes and double click on the wall and interfaces to open output for the walls in a separate window. From the selection box, choose output for the wall. Change to deformation shadings and afterwards to bending moments, shaded (see Figure 7.6).

![Figure 7.6](image)

Figure 7.6 Bending moments in the sheet pile wall at the end of the final phase
Similarly as for the wall, open an output window for the interfaces and display the total incremental displacements for the final phase (see Figure 7.7).

Figure 7.7  Total incremental displacements in the interfaces along the sheet pile wall for the final phase
### A.2 OUTPUT MENU

<table>
<thead>
<tr>
<th>Help</th>
<th>Window</th>
<th>Stresses</th>
<th>Deformations</th>
<th>Geometry</th>
<th>View</th>
<th>File</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manuals</td>
<td>Cascade</td>
<td>Effective Stresses</td>
<td>Deformed Mesh</td>
<td>Structures</td>
<td>Zoom In</td>
<td>Open</td>
<td>Copy</td>
</tr>
<tr>
<td>License</td>
<td>Tile</td>
<td>Cartesian Effective Stresses</td>
<td>Interfaces</td>
<td>Interfaces</td>
<td>Zoom Out</td>
<td>Close</td>
<td>Scale</td>
</tr>
<tr>
<td>Update</td>
<td>Horizontally</td>
<td>Phase Displacements</td>
<td>Materials</td>
<td>Materials</td>
<td>Reset View</td>
<td>Close All</td>
<td>Scan</td>
</tr>
<tr>
<td>Disclaimer</td>
<td>Vertically</td>
<td>Total Stresses</td>
<td>Phreatic Level</td>
<td>Phreatic Level</td>
<td>Viewpoint</td>
<td>Print</td>
<td>Line</td>
</tr>
<tr>
<td>About</td>
<td>(Active Windows)</td>
<td>Cartesian Total Stresses</td>
<td>Loads</td>
<td>Loads</td>
<td>Cross Section</td>
<td>Work Directory</td>
<td>Directory (Recent Projects)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Equivalent Stress</td>
<td>Fixities</td>
<td>Fixities</td>
<td>Table</td>
<td>Work</td>
<td>Exit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Isotropic Stress</td>
<td>Incremental Strains</td>
<td>Incremental Strains</td>
<td>Title</td>
<td>legend</td>
<td>Axes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Isotropic Preconsolidation Stress</td>
<td>Total Strains</td>
<td>Total Strains</td>
<td>Stress Points</td>
<td>Stress Points</td>
<td>Model Contour</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Plastic Points</td>
<td>Cartesian Incremental Strains</td>
<td>Cartesian Incremental Strains</td>
<td>Title</td>
<td>Title</td>
<td>Partial Geometry</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Active Pore Pressures</td>
<td>Active Pore Pressures</td>
<td>Active Pore Pressures</td>
<td>Model Contour</td>
<td>Distance Measurement</td>
<td>Material Set Numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Excess Pore Pressures</td>
<td>Excess Pore Pressures</td>
<td>Excess Pore Pressures</td>
<td>Model Contour</td>
<td>Distance Measurement</td>
<td>Material Set Numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Steady State Pore Pressures</td>
<td>Steady State Pore Pressures</td>
<td>Steady State Pore Pressures</td>
<td>Model Contour</td>
<td>Distance Measurement</td>
<td>Material Set Numbers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Groundwater Head</td>
<td>Groundwater Head</td>
<td>Groundwater Head</td>
<td>Model Contour</td>
<td>Distance Measurement</td>
<td>Material Set Numbers</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Geometry</th>
<th>View</th>
<th>Deformations</th>
<th>Stresses</th>
<th>Help</th>
<th>Window</th>
<th>File</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Window</td>
<td>Stresses</td>
<td>Geometry</td>
<td>View</td>
<td>File</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Deformations</td>
<td>Stresses</td>
<td>Geometry</td>
<td>View</td>
<td>File</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Help</td>
<td>Window</td>
<td>Stresses</td>
<td>Geometry</td>
<td>View</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Deformations</td>
<td>Stresses</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Geometry</td>
<td>Stresses</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>View</td>
<td>Stresses</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>File</td>
<td>Stresses</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Edit</td>
<td>Stresses</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Stresses</td>
<td>Help</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Help</td>
</tr>
</tbody>
</table>

---

**PLAXIS 3D Foundation Introductory Version**

A-2
### Floors and Walls:

<table>
<thead>
<tr>
<th>Deformations</th>
<th>Forces</th>
<th>Stresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Displacements</td>
<td>Axial N1</td>
<td>Cartesian Effective Stresses</td>
</tr>
<tr>
<td>Phase Displacements</td>
<td>Axial N2</td>
<td>Cartesian Total Stresses</td>
</tr>
<tr>
<td>Incremental Displacements</td>
<td>Shear Q12</td>
<td>Cross Section Stresses</td>
</tr>
<tr>
<td></td>
<td>Shear Q23</td>
<td>Effective Mean Stress (p')</td>
</tr>
<tr>
<td></td>
<td>Shear Q13</td>
<td>Total Mean Stress (p)</td>
</tr>
<tr>
<td></td>
<td>Bending Moments M11</td>
<td>Deviatoric Stresses (q')</td>
</tr>
<tr>
<td></td>
<td>Bending Moments M22</td>
<td>Equivalent Isotropic Stress</td>
</tr>
<tr>
<td></td>
<td>Torsion Moments M12</td>
<td>Isotropic Preconsolidation Stress</td>
</tr>
<tr>
<td></td>
<td>Groundwater Head</td>
<td>Isotropic Overconsolidation Ratio</td>
</tr>
</tbody>
</table>

### Cross sections:

<table>
<thead>
<tr>
<th>Deformations</th>
<th>Stresses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Displacements</td>
<td>Cartesian Total Stresses</td>
</tr>
<tr>
<td>Phase Displacements</td>
<td>Cross Section Stresses</td>
</tr>
<tr>
<td>Incremental Displacements</td>
<td>Total Strains</td>
</tr>
<tr>
<td></td>
<td>Cartesion Total Strains</td>
</tr>
<tr>
<td></td>
<td>Incremental Strains</td>
</tr>
<tr>
<td></td>
<td>Cartesian Incremental Strains</td>
</tr>
</tbody>
</table>

<p>| Groundwater Head        | Active Pore Pressure         |
|                         | Excess Pore Pressure         |
|                         | Steady State Pore Pressure   |
|                         | Groundwater Head             |</p>
<table>
<thead>
<tr>
<th>Stresses</th>
<th>Effective Normal Stresses</th>
<th>Vertical Shear Stresses</th>
<th>Horizontal Shear Stresses</th>
<th>Relative Shear Stresses</th>
<th>Active Pore Pressures</th>
<th>Excess Pore Pressures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interfaces:</td>
<td>Total Displacements</td>
<td>Phase Displacements</td>
<td>Incremental Displacements</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deformations</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### A.3 CURVES MENU

<table>
<thead>
<tr>
<th>Help</th>
<th>Manuals</th>
<th>License Update</th>
<th>Disclaimer</th>
<th>About</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Cascade</td>
<td>Tile Horizontally</td>
<td>Tile Vertically</td>
<td>(Active Windows)</td>
</tr>
<tr>
<td>Format</td>
<td>Curve</td>
<td>Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View</td>
<td>Zoom In</td>
<td>Reset View</td>
<td>Table</td>
<td>Legend</td>
</tr>
<tr>
<td>Edit</td>
<td>Copy</td>
<td></td>
<td></td>
<td>Value indication</td>
</tr>
<tr>
<td>File</td>
<td>New</td>
<td>Open</td>
<td>Save</td>
<td>Add Curve</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Delete Chart</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Close</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Close All</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Work Directory</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Print</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(Recent Projects)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Exit</td>
</tr>
</tbody>
</table>